# Contents

*What's New in Desktop Application Administration for the SAS 9.4 Intelligence Platform* .......................................................... vii

*Accessibility* ......................................................................................... xi

## Chapter 1 • Introduction to Desktop Application Administration

- About the Desktop Applications ......................................................... 1
- Installation Notes for Desktop Applications ..................................... 2
- Assistive Technologies Based on Windows ..................................... 3

## Chapter 2 • Common Elements

- Overview .......................................................................................... 5
- Migrating Desktop Applications ...................................................... 6
- Administering Connection Profiles for Desktop Applications ........ 6
- Administering Roles and Capabilities .............................................. 10
- Administering Logs and Other Local Files ..................................... 11
- Managing the Java Heap Used by Desktop Applications .............. 12

## Chapter 3 • Administering the SAS Add-In for Microsoft Office

- SAS Add-In for Microsoft Office Overview ...................................... 15
- Files Created by the SAS Add-In for Microsoft Office .................... 16
- Migrate SAS Content ....................................................................... 18
- Administer a Connection Profile for the SAS Add-In for Microsoft Office ............................................................... 19
- Select a Default Server for the SAS Add-In for Microsoft Office ...... 20
- Administer Profiles for the SAS Add-In for Microsoft Office .......... 22
- Administer Publishing by Instant Message ..................................... 23
- Administer SAS Functionality in Microsoft Outlook ...................... 23
- Set Refresh Options for SAS Functionality in Outlook ................. 24
- Manage Multiple Instances on a Single Host ................................. 25
- Configure the SAS Add-In for Microsoft Office for Grid Computing 26
- Configure the SAS Add-In for Microsoft Office for Parallel Execution 28
Configure SAS Add-In for Microsoft Office to Access a Locked-Down SAS Server ............................................. 29
Configure SAS Add-In for Microsoft Office to Turn Off the Automatic Check for Updates Feature ......................... 29
Configure SAS Add-In for Microsoft Office to Hide the Check for Updates Option ............................................. 30
Tasks That Require Other SAS Software .......................... 31
Default Roles and Capabilities for the SAS Add-In for Microsoft Office .......................................................... 32
Registering Custom Tasks as Capabilities in the SAS Add-In for Microsoft Office .................................................. 47
Library Access for the SAS Add-In for Microsoft Office ...... 51

Chapter 4 • Administering SAS OLAP Cube Studio ................................................................. 53
SAS OLAP Cube Studio Overview for Administrators .......... 53
Setting Up the SAS Intelligence Platform for SAS OLAP Cube Studio ......................................................... 54
Understanding the Configuration of SAS OLAP Cube Studio ............................................................. 55
Administering OLAP Sessions and Queries ......................... 55
Administering SAS OLAP Servers ................................. 56

Chapter 5 • Administering SAS Data Integration Studio ............................................................... 57
Overview of Administering SAS Data Integration Studio .... 59
Connecting to SAS Servers ............................................. 61
Connecting to Data Servers ............................................. 63
About Scheduling Servers ................................................ 64
Setting Up Change Management ...................................... 64
Setting Up Multi-Tier Environments ................................ 68
Administering Message Queues ....................................... 74
Configuring the SAS Workspace Server to Enable the Bulk Loading of Data .................................................. 79
Setting X Command Options to Run Perl or Shell Scripts .... 81
Setting Up the SAS Data Quality Server Software ............... 81
Redirecting Output and Logging Information to a File ......... 87
Enabling Status Code Handling ........................................ 88
Using FTP or HTTP Servers to Access External Files .......................... 90

Chapter 6 • Administering SAS Enterprise Guide .................................................. 93
  Overview of SAS Enterprise Guide Administration ............................................ 95
  Migrate SAS Content with the Migration Wizard .............................................. 97
  Managing Connection Profiles in SAS Enterprise Guide ............................. 104
  Review Library Access in SAS Enterprise Guide ........................................... 114
  Managing Libraries with SAS Enterprise Guide Explorer ........................... 117
  Configure SAS Enterprise Guide for Integrated
    Windows Authentication ............................................................................... 121
  Configure SAS Enterprise Guide for Grid Computing .................................. 122
  Configure SAS Enterprise Guide for Parallel Execution ............................ 123
  Configure SAS Enterprise Guide to Access a
    Locked-Down SAS Server ........................................................................ 124
  Configure SAS Enterprise Guide to Turn Off the
    Automatic Check for Updates Feature ...................................................... 124
  Configure SAS Enterprise Guide to Hide the Check
    for Updates Option .................................................................................. 125
  Tasks That Require Other SAS Software ..................................................... 126
  Default Roles and Capabilities for SAS Enterprise Guide .......................... 126
  Registering Custom Tasks as Capabilities in SAS
    Enterprise Guide .................................................................................... 143

Chapter 7 • Administering SAS Enterprise Miner .................................................... 147
  SAS Enterprise Miner Overview for Administrators .................................... 147
  Administrative Tasks in SAS Enterprise Miner ............................................ 147

Chapter 8 • Administering SAS Information Map Studio ........................................ 149
  SAS Information Map Studio Overview for Administrators ....................... 150
  Add Users to SAS Information Map Studio ................................................. 151
  Register Resources as Input to SAS Information Maps ............................ 151
  Access Control for SAS Information Maps ................................................ 152
  Pooled Workspace Server ........................................................................... 153
  Log Files ..................................................................................................... 154
  Memory Allocation ....................................................................................... 156
  Configuration File ......................................................................................... 156
What's New in Desktop Application Administration for the SAS 9.4 Intelligence Platform

Overview

The SAS Intelligence Platform: Desktop Application Administration Guide contains the following additions and enhancements:

- new documentation for the Migration Wizard that is used in SAS Enterprise Guide and in the SAS Add-In for Microsoft Office
- new capabilities that enhance access control in SAS Enterprise Guide and in the SAS Add-In for Microsoft Office
- new documentation that describes how to configure temporary storage for parallel execution in SAS Enterprise Guide and in the SAS Add-In for Microsoft Office
- new documentation that describes how to configure SAS Enterprise Guide to work with locked-down SAS servers
- new documentation that describes how to configure SAS Enterprise Guide to access a SAS Metadata Server using Integrated Windows authentication
- revised methods of specifying Java options and specifying the plug-in location when you start SAS Management Console
Documentation Enhancements

For SAS 9.4, the SAS Intelligence Platform: Desktop Application Administration Guide contains enhancements for the following applications.

SAS Add-In for Microsoft Office

The chapter for the SAS Add-In for Microsoft Office contains the following updates:

- A new section describes how to use the Migration Wizard to update your SAS content. The wizard updates file formats and metadata references. The Migration Wizard can be supplied with XML source files to apply standardized changes to multiple hosts. For many previous releases, migration also takes place automatically when you open your SAS content in the latest release.

- To support parallel execution, a new section describes how to configure temporary storage on pooled SAS Workspace Servers.

- In the first maintenance release for SAS 9.4, there are three new capabilities added to the “Default Capabilities Assigned to Roles for the SAS Add-In for Microsoft Office” table.

- In the first maintenance release for SAS 9.4, a new section describes how to create an initial custom profile deployment.

- In the first maintenance release for SAS 9.4, a new section describes how to configure SAS Add-In for Microsoft Office to access SAS servers that are configured in lockdown mode.

- In the SAS Add-In 7.1 for Microsoft Office, there are four new capabilities added to the “Default Capabilities Assigned to Roles for the SAS Add-In for Microsoft Office” table.

- In the third maintenance release for SAS 9.4, two new sections were added:
Configure SAS Add-In for Microsoft Office to Turn Off the Automatic Check for Updates Feature

Configure SAS Add-In for Microsoft Office to Hide the Check for Updates Option

SAS Enterprise Guide

The chapter for SAS Enterprise Guide contains the following updates:

- A new section describes how to use the Migration Wizard to update file formats and metadata references. You can use any of several XML files to specify standardized changes to multiple hosts.

- Fifteen capabilities now more clearly delineate access to projects. An additional three capabilities have new descriptions.

- A new section describes how to configure temporary storage for parallel execution on pooled SAS Workspace Servers.

- In the first maintenance release for SAS 9.4, there are four new capabilities added to the “Default Capabilities Assigned to Roles for SAS Enterprise Guide” table.

- In the first maintenance release for SAS 9.4, a new section describes how to create an initial custom profile deployment.

- In the first maintenance release for SAS 9.4, a new section describes how to configure SAS Enterprise Guide to access SAS servers that are configured in lockdown mode.


- In the SAS Enterprise Guide 7.1 release, there are seven new capabilities added to the “Default Capabilities Assigned to Roles for SAS Enterprise Guide” table.

- In the SAS Enterprise Guide Explorer Version 7.1, the ability to add library definitions to metadata was removed.
In the third maintenance release for SAS 9.4, if a DBMS library is set to PROMPT and the server version is the third maintenance release for SAS 9.4 or later, then SAS Enterprise Guide prompts for user credentials and passes them to the META engine using the DBUSER= and DBPASS= LIBNAME options.

In the third maintenance release for SAS 9.4, the following two sections were added:

- Configure SAS Enterprise Guide to Turn Off the Automatic Check for Updates Feature
- Configure SAS Enterprise Guide to Hide the Check for Updates Option

SAS Management Console

The chapter for SAS Management Console has been updated to address changes in how you start the plug-in. Changes include a revised method of specifying Java options and a revised method of specifying the location of the plug-in.
For information about the accessibility of any of the products mentioned in this document, see the usage documentation for that product.
About the Desktop Applications

The SAS Intelligence Platform includes the following desktop applications:

SAS Add-In for Microsoft Office
   brings the power of SAS to Microsoft Excel, Word, and PowerPoint.

SAS Data Integration Studio
   enables enterprise data collection, analysis, reporting, and publishing using a
   graphical process designer and numerous data transformation templates.

SAS Enterprise Guide
   provides a point-and-click interface for data querying, reporting, analysis, and SAS
   programming.
SAS Enterprise Miner
provides a point-and-click interface for creating predictive models that identify
trends, opportunities, and threats based on the analysis of data from across your
enterprise.

SAS Information Map Studio
provides a point-and-click interface for the creation and maintenance of information
maps. Information maps are metadata definitions of enterprise data that provide a
basis for querying and reporting.

SAS Management Console
provides the primary administrative interface for the SAS Intelligence Platform.

SAS OLAP Cube Studio
provides a straightforward wizard interface for building, updating, and tuning SAS
OLAP cubes.

Administrative information for client applications that run in a web browser is provided in
the SAS Intelligence Platform: Web Application Administration Guide. The web
applications include SAS Web Report Studio, SAS Web OLAP Viewer, and the SAS
Information Delivery Portal.

---

Installation Notes for Desktop Applications

You initially install desktop applications as part of your overall deployment plan, as
described in the SAS Intelligence Platform: Installation and Configuration Guide.

After you install a desktop application, it is important for you to know that the
configuration process might not end at that point. Check the chapter in this document
for each desktop application to ensure that you complete the configuration process. You
might need to configure libraries, update user permissions, or change memory
allocations.
Assistive Technologies Based on Windows

For assistive technologies based on Windows, you need to download the Java Access Bridge (JAB) from this URL: http://www.oracle.com/technetwork/java/. The SAS Java applications that run on Windows are listed under “Clients” in the “Architecture of the SAS Intelligence Platform” in SAS Intelligence Platform: Overview.

After downloading the JAB, you need to customize the standard installation procedure to facilitate access to it. This setup assumes that Java is already installed on the machine. A known risk is that SAS applications can be corrupted by JAR files that might be installed in the jre/lib/ext directory. To solve this problem, SAS has implemented a custom class loader to replace the system class loader. The custom class loader loads only approved extensions that SAS configures based on the JRE the vendor provides. A consequence of hiding the existing directory is that it disables installed accessibility-related applications. To configure SAS Java applications to permit access to the Java Access Bridge:

1. On the client machine, locate all copies of the file sas.java.ext.config.

2. In each instance of the file, edit the file in a plain text editor, such as Microsoft Notepad.

3. Add the following two lines to the bottom of the file:

   access-bridge.jar
   jaccess-1_4.jar

   Note: The filename of the jaccess*.jar file depends on the version of the JRE. Listed here is the filename for Version 1.4. If you are using a different version, your filename varies.

4. Save the changes and close the file.
Note: If your site runs desktop applications on remote hosts, assistive technologies, such as JAWS screen reader, might require additional licensing and configuration to be fully functional. This situation has been observed when applications are executed with Citrix software.
Common Elements

Overview

Migrating Desktop Applications

Administering Connection Profiles for Desktop Applications
- Overview of Connection Profiles
- About Integrated Windows Authentication
- About Default Connection Profiles
- Disable the Option to Store Credentials in Profiles
- Change, Create, Delete, or Edit a Connection Profile

Administering Roles and Capabilities

Administering Logs and Other Local Files
- Default Directories
- About the Desktop Application Log Files

Managing the Java Heap Used by Desktop Applications

Overview

The common elements in the administration of desktop applications include logging and local files, heap (memory) management, connection profiles, and roles and capabilities. The common elements apply to the group of desktop applications that are unique to the

**Migrating Desktop Applications**

The desktop applications do not have an explicit migration path. You simply remove the previous version and install the new version in its place. When you start the desktop applications for the first time, the application makes whatever migrations are necessary.

**CAUTION!** Do not run the SAS Migration Utility on hosts that run desktop applications.

For a description of application changes, refer to the What's New and Special Considerations documents.

**Administering Connection Profiles for Desktop Applications**

**Overview of Connection Profiles**

During initialization, SAS desktop applications use a connection profile to connect to a SAS Metadata Server. A successful connection enables secure access to the enterprise resources that are defined in metadata.

Connection profiles are stored on the hosts of the desktop applications at `C:\Documents and Settings\user-name\Application Data\SAS\MetadataServerProfiles`.

In the Windows Vista or later operating environments, the path is `C:\Users\user-name\AppData\Roaming\SAS\MetadataServerProfiles`. The names of the profiles use the file extension `.swa`.

In the UNIX operating environment, the path is `/user-home/.SASAppData/MetadataServerProfiles`.

Selecting a different profile closes all server connections and terminates any active jobs.

Connections depend on the version of the SAS Metadata Server. Older desktop applications that were delivered with SAS 9.1.3 connect only to the SAS 9.1.3 Metadata Server. Newer applications that were delivered with SAS 9.2 connect only to the SAS 9.2 Metadata Server. For more information, see SAS Add-In for Microsoft Office Software Compatibility by Release on page 26 and SAS Enterprise Guide Software Compatibility by Release on page 105.

Users can change, edit, or delete connection profiles at any time.

A successful connection to a metadata server is required to fully initialize the following desktop applications:

- SAS Data Integration Studio
- SAS Information Map Studio
- SAS Management Console
- SAS OLAP Cube Studio

The preceding applications use a common interface for connection profiles, as described in this section.

The following desktop applications do not require a connection to a SAS Metadata Server, and they use a different interface for connection profiles:

- SAS Enterprise Guide
- SAS Add-In for Microsoft Office
- SAS Enterprise Miner

Connection profile information for the preceding applications is provided in the chapters of this book that are dedicated to those applications.

**About Integrated Windows Authentication**

Connection profiles enable users to specify that authentication be performed using Integrated Windows authentication. This type of authentication enables users to connect to SAS Metadata Servers and SAS Workspace Servers without transmitting a name and
password over the network. The client and server transmit authentication tokens to a host, and that host confirms or denies the authentication.

Integrated Windows authentication applies only to servers that are installed on a Windows host.

See Also

- SAS Intelligence Platform: Security Administration Guide
- “Configure SAS Enterprise Guide for Integrated Windows Authentication” on page 121

About Default Connection Profiles

At installation time, most of the desktop applications create a default connection profile. For all of these applications other than SAS Management Console, the default connection profile prompts users to authenticate using credentials from the operating environment. The resulting connection provides information that enables the assignment of permissions.

After you install a desktop application, users should be directed to create new connection profiles. The new profile implements the users, groups, and roles that are defined at your site.

Disable the Option to Store Credentials in Profiles

When you create a connection profile, the Connection Profile Wizard provides, by default, a check box named Save user ID and password in this profile. If a user selects this check box, then the user's ID and password are stored in the user's connection profile on the local file system. Saving the ID and password in the profile allows users to reconnect in the future without entering these values again.

Follow these steps to remove the Save user ID and password in this profile check box from the Connection Profile Wizard and require the manual entry of credentials:

1. On the host of the SAS Metadata Server, open in a text editor the file omaconfig.xml.
2 Change the value of the option SASSEC_LOCAL_PW_SAVE from 1 (or y or t) to 0 (or n or f).

3 Save and close the file.

4 Restart the SAS Metadata Server as directed in the SAS Intelligence Platform: System Administration Guide.

After you change the setting for this option and restart the metadata server, each client uses the previous setting for its first connection. The client then discovers the revised setting and conforms to that revised setting for subsequent connections.

If you change the setting to disallow saved credentials, and credentials are already present in a user’s connection profile, those credentials must be manually removed.

**Change, Create, Delete, or Edit a Connection Profile**

To create, change, delete, or edit a connection profile, follow these steps:

1 Open the desktop application. If you specified a connection profile previously, then the application uses that profile.

2 If directed to do so, enter your user ID and password.

3 Select **File ➤ Connection Profile** and click **Yes** to display the Connection Profile window.

4 To change from the current profile to another profile, click the down arrow, select the other profile, and click **OK**.

5 To delete an existing profile, click **Delete** and **Yes**. Deletion removes all of the connection information in that profile. Select another profile to continue using the application.

6 To edit an existing connection profile, click the down arrow to select the profile, and then click **Edit** to open the Edit Connection Profile wizard. Add profile information as
directed by the wizard, and then click **Finish**. In the Connection Profile window, click OK to connect to the specified SAS Metadata Server using the edited profile.

7 To create a new connection profile, click **Create a New Connection Profile** and click OK to display the Connection Profile Wizard. Add profile information as directed by the wizard, and then click **Finish**. In the Connection Profile window, click OK to connect to the specified SAS Metadata Server using the new profile.

---

**Administering Roles and Capabilities**

When users are assigned to roles, they gain access to certain capabilities in certain applications. Roles are implemented in the following desktop applications:

SAS Management Console  
See “Administering Roles” on page 165.

SAS Enterprise Guide  
See “Default Roles and Capabilities for SAS Enterprise Guide” on page 126.

SAS Add-In for Microsoft Office  
See “Default Roles and Capabilities for the SAS Add-In for Microsoft Office” on page 32.

Roles and capabilities are also implemented in SAS Web Report Studio, as described in the *SAS Intelligence Platform: Web Application Administration Guide*.

Roles are added, deleted, and changed in the User Manager in SAS Management Console.

For more information about roles and capabilities, see the *SAS Intelligence Platform: Security Administration Guide*. 
Administering Logs and Other Local Files

Default Directories

The desktop applications maintain local files on the C: drives of their respective hosts. Local files contain information that is specific to users.

By default, in the Windows operating environment, local files are stored in the Users directory.

Windows path to local files: `C:\Users\user-name\Application Data\SAS\application-name`

Connection profiles: `C:\Users\user-name\Application Data\SAS\MetadataServerProfiles`

Log files: `C:\Users\user-name\Application Data\SAS\Logs`

The Windows Vista operating environment uses the following path: `C:\Users\user-name\AppData\Roaming\SAS`.

About the Desktop Application Log Files

The Logs directory contains the following log files for the following desktop applications: SAS Management Console, SAS Data Integration Studio, SAS OLAP Cube Studio, and SAS Information Map Studio.

<table>
<thead>
<tr>
<th>Action</th>
<th>Source</th>
<th>Filename</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import package</td>
<td>SAS Import Package Wizard</td>
<td>Import_{yyMMddHHmmss}.log</td>
</tr>
<tr>
<td>Export package</td>
<td>SAS Export Package Wizard</td>
<td>Export_{yyMMddHHmmss}.log</td>
</tr>
<tr>
<td>Action</td>
<td>Source</td>
<td>Filename</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Batch import</td>
<td>Import Package Tool</td>
<td>Import_yyMMddHHmmss.log</td>
</tr>
<tr>
<td>Batch export</td>
<td>Export Package Tool</td>
<td>Export_yyMMddHHmmss.log</td>
</tr>
<tr>
<td>Copy, paste, and paste special</td>
<td><strong>Edit</strong> menu</td>
<td>CopyPaste.log</td>
</tr>
</tbody>
</table>


**Managing the Java Heap Used by Desktop Applications**

The Java heap is a segment of host memory that certain desktop applications use to manage their graphical user interface. The size of the Java heap is 512 megabytes for SAS Management Console, SAS Data Integration Studio, and SAS OLAP Cube Studio. SAS Information Map Studio dynamically allocates heap memory, using a minimum of 500 megabytes and a maximum of 1024 megabytes.

Follow these steps if you need to increase the size of the Java heap for one of the preceding desktop applications:

1. Open the application's INI file using the path `SAS-installation-directory\SAS\application-name\release-number`. Note that your site might use a different installation directory for SAS.
2. Increase the default value `Xmx512m` to something higher, such as `Xmx1024m`.
3. Save and close the INI file.
4. Restart the desktop application.
If your desktop applications run in the Citrix application delivery environment, then you can increase the size of your Java heap to the Citrix limit. Although some versions of Citrix support higher limits, all versions support a maximum Java heap size of 512 megabytes.
Administering the SAS Add-In for Microsoft Office

SAS Add-In for Microsoft Office Overview ............................................. 16
Files Created by the SAS Add-In for Microsoft Office ....................... 18
Migrate SAS Content ............................................................................. 19
Administer a Connection Profile for the SAS Add-In for Microsoft Office .................................................. 20
Create a Connection Profile ................................................................. 20
Deploy Customized Options ............................................................... 21
Select No-Profile Mode ..................................................................... 22
Select a Default Server for the SAS Add-In for Microsoft Office .......... 22
Administer Profiles for the SAS Add-In for Microsoft Office ............. 23
Administer Publishing by Instant Message ....................................... 23
Administer SAS Functionality in Microsoft Outlook ....................... 24
Configure the Distribution of SAS Content ..................................... 24
Configure the Addition of Comments to Reports .......................... 24
Configure Access to Indicators and Dashboards .............................. 24
About Menus in Outlook 2007 ......................................................... 25
Set Refresh Options for SAS Functionality in Outlook .................. 25
SAS Add-In for Microsoft Office

Overview

The SAS Add-In for Microsoft Office is a Component Object Model (COM) add-in. It extends Microsoft Office to use the power of SAS data access, analysis, and reporting
directly from Microsoft Outlook, Excel, Word, and PowerPoint. To see the power of SAS in these applications, open the SAS tab or menu.

The SAS Add-In 4.3 and 4.305 for Microsoft Office supports the following products:

- Microsoft Outlook 2007 and 2010

The SAS Add-In 5.1 for Microsoft Office supports the following products:


The SAS Add-In 6.1 for Microsoft Office supports the following products:


The SAS Add-In 7.1 for Microsoft Office supports the following products:


After you install the SAS Add-In for Microsoft Office, certain administrative tasks need to be completed. The administrative tasks are summarized in the following table.

**Table 3.1 Administrative Tasks for SAS Add-In for Microsoft Office**

<table>
<thead>
<tr>
<th>Administrative Task</th>
<th>Purpose of Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administer a connection profile</td>
<td>Add, modify, or delete a profile. Set the active profile.</td>
</tr>
<tr>
<td>Select a default server</td>
<td>Specify which server you want to access by default.</td>
</tr>
<tr>
<td>Administer profile configuration updates</td>
<td>Create a configuration update file that can be modified and used each time the Microsoft applications are initialized.</td>
</tr>
<tr>
<td>Administer files</td>
<td>Specify the location of the add-in administration files.</td>
</tr>
<tr>
<td>Administer roles</td>
<td>Limit access to certain features for certain users.</td>
</tr>
</tbody>
</table>
Administrative Task | Purpose of Task
--- | ---
Grant library access | Administer access to registered libraries.

For additional information about using the SAS Add-In for Microsoft Office, right-click the SAS tab or menu in the Microsoft software and select Help. See also the product web page: http://support.sas.com/software/products/addin/index.html.

Files Created by the SAS Add-In for Microsoft Office

By default, the SAS Add-In for Microsoft Office generates various files, including configuration files and log files.

On Windows 7 and 8, these files are located, by default, in C:\Users\user-ID\AppData\Roaming\SAS\Add-InForMicrosoftOffice\version.

On Windows XP, the files are located in C:\Documents and Settings\user-ID\Application Data\SAS\Add-InForMicrosoftOffice\version.

A path that applies to all supported versions of Windows is %APPDATA%\SAS\Add-InForMicrosoftOffice\version.

Information that is shared between SAS Add-In for Microsoft Office and SAS Enterprise Guide, such as favorites, settings for SAS Central, and some views, is stored at C:\Users\user-id\AppData\Roaming\SAS\SharedSettings\7.1.

Metadata server profiles that are shared between SAS Add-In for Microsoft Office and SAS Enterprise Guide are stored at C:\Users\user-id\AppData\Roaming\SAS\MetaDataServerProfiles.
Migrate SAS Content

You can migrate SAS content in your Microsoft Office files in two ways. You can refresh individual files or you can migrate any number of files using the Migration Wizard.

Refreshing individual files updates the SAS content to the latest file format. In some cases, you can still open those files in previous versions of the SAS Add-In for Microsoft Office, as described later in this section.

The Migration Wizard is particularly useful when you want to perform the following tasks:

- migrate a large number of files to a new version of the SAS Add-In for Microsoft Office
- migrate to a new metadata repository
- update multiple metadata references in your SAS content

For information about using the Migration Wizard, see “Migrate SAS Content with the Migration Wizard” on page 97.

In SAS Add-In 6.1 for Microsoft Office and later, you can migrate individual documents by refreshing them in the latest version of the SAS Add-In for Microsoft Office. You can open documents that contain SAS content that was generated with prior releases 2.1, 4.2, 4.3, or 5.1.

If you refresh a document from any previous release, and if you add new content in the 5.1 or later release, do not open the document in any previous release.

Content that was generated in the 4.2 or 2.1 release must be refreshed before you can use the restore content functionality.

If you open content from the 4.2 release and the Show Preview Changes dialog box check box is selected on the Results tab in the SAS Options dialog box, then you can select what content to include in the results and what content to hide. However, because this is migrated content, the SAS add-in might not find the original results to
know which content to hide. If the SAS add-in cannot find the original results, then all of the results are displayed.

To ensure that you are using the latest version of the data, refresh any data sources in your document before you use this data in the SAS Add-In for Microsoft Office. For example, measures that were available to a PivotTable in the 4.3 release might not be available in the 5.1 or later release because you are connecting to a different server for the 5.1 or later release. When you refresh your data, any measures that no longer exist are removed from the PivotTable.

When you refresh a document from a previous release in the 5.1 or later release, you might notice that the style for the output has changed. To work around this problem:

1. Before you refresh the content in 5.1 or later, select the content in Microsoft Excel, Microsoft Word, or Microsoft PowerPoint, and then click Properties.

2. In the Properties dialog box, select the style that you want to use, and then refresh the content in 5.1 or later.

**Administer a Connection Profile for the SAS Add-In for Microsoft Office**

**Create a Connection Profile**

A connection profile defines the connection between the SAS Add-In for Microsoft Office and a SAS Metadata Server. The SAS Metadata Server contains metadata definitions for objects such as workspace servers, libraries, and users. These definitions are used by the SAS add-in and other SAS applications. The SAS Metadata Server connection provides secure access to enterprise servers and data sources.

The Connections window provides the interface to Profiles, Servers, and Updates. Any changes made to the connections are applied to SAS Enterprise Guide and to all Microsoft applications that use the SAS add-in. To access the Connections window, follow these steps:
In Microsoft Office 2007 and later, select the **SAS** tab in the Ribbon, and select **Tools ▶ Connections**. The Connections window appears.

In Microsoft Outlook 2010, click the **SAS** tab in the Ribbon. In the **Tools** group, click **Connections**.

In Microsoft Outlook 2007, select **SAS Central Options**. In the Options dialog box, click the **SAS** tab, and then click **Connections**.

To configure the Profiles, Servers and Updates, refer to the online Help.

In Microsoft Office 2007 and later, click **SAS ▶ Help ▶ Help for SAS Add-In for Microsoft Office**.

### Deploy Customized Options

Follow these steps to deploy a standardized set of site-specific SAS Add-In for Microsoft Office options:

1. Using the SAS Add-In for Microsoft Office client (for example, Excel), on the SAS ribbon select **Tools ▶ Options**.

2. Adjust the options as desired.

3. Close the SAS Add-In for Microsoft Office client.

4. Locate the AMOOptions.xml file (usually located in `%appdata%\SAS\Add-InForMicrosoftOffice\version`).

5. Edit a copy of the AMOOptions.xml file to remove any user-specific settings, such as pathnames.

6. To deploy SAS Add-In for Microsoft Office with customized options, copy the file AMOOptions.xml from your host into your SAS software depot. Copy the file into the top-level directory for SAS Add-In for Microsoft Office. Here is a typical network location:

   ```plaintext
   \depot-host\Depot_date_type\products\msofficeint_release_release_win_en_sp0_1
   \depot-host\Depot_date_type\products\msofficeint_release_release_wx6_en_sp0_1
   ```
Note: Review the AMOptions.xml file and remove any option values that are user specific.

Select No-Profile Mode

You can create a profile that connects you to the metadata repository that is installed on the local host. This type of profile supports single-machine configurations. You can also use the add-in without a profile, although you can access only a SAS server installed on your local machine.

To invoke no-profile mode, open the Connections window by selecting SAS ▶ Tools ▶ Connections. The Connections window is displayed. Select Profiles ▶ <do not use a profile> from the list of available profile-related actions. Click the Set Active button to make it the active profile.

Select a Default Server for the SAS Add-In for Microsoft Office

Using the Connections window, you can specify which server you want to access. You connect to a server to access data sources and to run SAS tasks. To select a server for the active profile, follow these steps:

1. Open the Connections window as described in Create a Connection Profile on page 20.

2. Click Servers, click the down arrow, and select a default SAS server.

3. (Optional) Select Automatically add local SAS server (if installed) to the list.

Note: Performance improvements can be achieved when groups of users select a load-balancing cluster of SAS Workspace Servers. For information about load-balancing, see the SAS Intelligence Platform: Application Server Administration Guide.
Administer Profiles for the SAS Add-In for Microsoft Office

You can deploy SAS Enterprise Guide and SAS Add-In for Microsoft Office clients with an automatic default connection profile. See “Create an Automatic Default Connection Profile Deployment” on page 108.

You can deploy and maintain connection profiles from a central location, and you can update profiles automatically from that central location when you start SAS Enterprise Guide. See “Create a Shared Profile Deployment with Automatic Updates” on page 108.

You can deploy an initial custom profile, which requires creating a configuration profile without credentials and saving it in the SAS software depot. See “Create an Initial Custom Profile Deployment” on page 110.

Administer Publishing by Instant Message

After you run a report in Microsoft Outlook, you can share the results in an instant messaging tool, such as Microsoft Office Communicator or Microsoft Lync. The options that are available depend on your version of Microsoft Outlook and the communicator tool that you are using.

In order for you to appear as a contact for a report, your name in Microsoft Office Communicator or Lync must match the name in SAS Management Console. Update your name accordingly in SAS Management Console. For example, if your name in Office Communicator appears as John Smith, and if your name is listed as Smith, John in SAS, then you do not appear as a contact when you create a report. Update your name accordingly in the User Manager in SAS Management Console.
Administer SAS Functionality in Microsoft Outlook

Configure the Distribution of SAS Content

Outlook capabilities govern the distribution of SAS content (email, save, print, and send.) For details about these capabilities, see “Default Roles and Capabilities for the SAS Add-In for Microsoft Office” on page 32.

Configure the Addition of Comments to Reports

To use the commenting functionality in Microsoft Outlook, you must run the first maintenance release for SAS Web Report Studio 4.31 or later for SAS Web Report Studio comments. If you have access to a Visual Analytics server, you can use the commenting functionality with Visual Analytics reports.

To read and create messages using the SAS Comment Server, your role needs to be granted the Comments capability. Without the Comments capability, the Comment icon in the Ribbon is hidden, as is the Comment pane in the Preview, Inspector View, and Gadget panes.

To edit and delete comments, you need to be a member of the group Comments:Administrator.

Configure Access to Indicators and Dashboards

To view dashboards in Microsoft Outlook, your site must be running the first maintenance release for SAS BI Dashboard 4.31 or later.

The Open BID Content capability in the Open or Import category enables users to open indicators and dashboard content in Outlook. This capability is not granted by default to any role.
The dashboard functionality is identified as EXPERIMENTAL in the SAS Add-In 6.1 for Microsoft Office and SAS Add-In 7.1 for Microsoft Office.

**About Menus in Outlook 2007**

In Microsoft Outlook 2007, menus and menu options cannot be disabled by add-ins. This means that users of the SAS add-in can select menu options that are disabled by SAS capabilities. If you select a disabled menu option, an error message is displayed to indicate that the menu option has been disabled by a capability.

**Note:** When you are installing the SAS Add-In for Microsoft Office, excluding the selection for Outlook is an option. However, the resulting installation might present the SAS Add-In for Microsoft Office menu selections in Outlook 2007 anyway. If you have the latest SAS Add-In 5.1 for Microsoft Office hotfix or SAS Add-In 6.1 for Microsoft Office or later release, then you can access the **SwitcherUtility** in the installation directory and deselect **Outlook**.

---

**Set Refresh Options for SAS Functionality in Outlook**

The following options govern refresh rates for SAS functionality in Microsoft Outlook:

**CommentPaneRefreshRate**

specifies the frequency at which the Comment Pane is updated with new data from the SAS Comment Server. The default value of this option is 5 (minutes). Valid values range from 0 (no refresh) to 1440 (24 hours). Settings remain valid for the duration of a connection. Restart Outlook to verify a change in the refresh rate.

**GadgetPaneRefreshRate**

specifies the frequency of updates for the Gadget Pane. The default value of this option is 60 (minutes). Valid values range from 0 (no refresh) to 1440 (24 hours). Settings remain valid for the duration of a connection. Restart Outlook to verify a change in the refresh rate.

To display or change the values of the refresh options, follow these steps:
1. Open SAS Management Console.

2. In the **Plug-ins** tab, expand **Application Management**.

3. Expand **Configuration Manager**.

4. Right-click **Add-In 5.1 for Microsoft Office**, **Add-In 6.1 for Microsoft Office**, or **Add-In 7.1 for Microsoft Office** and select **Properties**.

5. In the Properties dialog box, click the **Advanced** tab.

---

**Manage Multiple Instances on a Single Host**

You can now use different versions of the SAS Add-In for Microsoft Office to access different versions of SAS content:

**Table 3.2**  *SAS Add-In for Microsoft Office and SAS Software Release*

<table>
<thead>
<tr>
<th>SAS Add-In for Microsoft Office</th>
<th>SAS Software Release</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>9.1.3</td>
</tr>
<tr>
<td>2.1</td>
<td>yes</td>
</tr>
<tr>
<td>4.x</td>
<td>no</td>
</tr>
<tr>
<td>5.1</td>
<td>no</td>
</tr>
<tr>
<td>6.x</td>
<td>no</td>
</tr>
<tr>
<td>7.1</td>
<td>no</td>
</tr>
</tbody>
</table>

Use the SAS Add-In for Microsoft Office Utility to select a release of the SAS add-in. Administrative permissions are required. You can use only one release at a time, and that release must be installed on the local host.
Note: You should use the most recent version of the SwitcherUtility to change versions, regardless of which version you are changing to or from.

To access the SAS Add-In for Microsoft Office Utility, open Windows Explorer and double-click SwitcherUtility.exe in the SAS add-in installation directory `C:\Program Files\SASHome\SASAddinForMicrosoftOffice` for 64-bit versions, and `C:\Program Files\SASHome\x86\SASAddinForMicrosoftOffice` for 32-bit versions. You must use only one release of the SAS add-in for all Microsoft Office applications.

To access the SAS Add-In for Microsoft Office Utility from a command line, enter the following command into a DOS prompt:

```
cd C:\Program Files\SAS\Add-inForMicrosoftOffice
```

Now enter the following command, using your choice of arguments:

```
SwitcherUtility.exe <application> <silent>
```

The arguments are defined as follows:

**application**

enables or disables the SAS add-in in specified Microsoft Office applications. Use `+application` to enable, and `-application` to disable. Valid values of **application** are Excel, PowerPoint, Word, and Outlook. In a single command, you can enable certain applications and disable others for the specified release of the SAS add-in, as shown in the following example:

```
SwitcherUtility.exe 7.1 +Excel +PowerPoint +Outlook -Word
```

**silent**

specifies that no output from the utility is to be displayed in the DOS window.

All arguments are optional. Specifying the command with no arguments opens the SAS Add-In for Microsoft Office Utility.
Configure the SAS Add-In for Microsoft Office for Grid Computing

To configure a SAS grid to distribute the workload from the SAS Add-In for Microsoft Office, use the SAS Grid Manager. For assistance, refer to Grid Computing in SAS.

To configure a Microsoft Office application to use a SAS grid, select SAS ▶ Tools ▶ Options. In the SAS Options dialog box, click the Tasks tab and select Use grid when available.

Configure the SAS Add-In for Microsoft Office for Parallel Execution

To use the features Quick Stats and Auto Chart in the SAS Add-In for Microsoft Office, you need to configure client-managed pooled SAS Workspace Servers. These features cause the add-in to open new workspace server sessions to enable parallel execution. As the sessions become idle, they terminate.

The parallel workspace server sessions cooperate and store results files in a temporary shared results directory. Results files are retrieved from that directory for display by the add-in. An example of a results file is a graph that is created by Quick Stats. The temporary shared results directory is deleted upon termination of the workspace server session.

The temporary shared results directory is created in a location that is subordinate to the path specified in the WORK= system option for the SAS Workspace Server.

In the z/OS operating environment, the WORK= system option must refer to a UNIX file system path to enable Quick Stats and Auto Chart. If the WORK= system option refers to a native MVS bound library, those features are disabled. The following specification places the WORK library in a UNIX file system directory: WORK=/tmp.
To configure a SAS Workspace Server with the WORK= system option, specify 
\texttt{WORK=/tmp} in the following file:

\texttt{config-dir/Lev1/SASApp/WorkspaceServer/sasv9_usermods.cfg}

If your pooled SAS Workspace Servers are configured under a single SAS Application 
Server, then you can set the WORK= system option once in the following file:

\texttt{config-dir/Lev1/SASApp/sasv9_usermods.cfg}

To create client-enabled pooled SAS Workspace Servers, see the \textit{SAS Intelligence 
Platform: Application Server Administration Guide}.

\section*{Configure SAS Add-In for Microsoft Office to Access a Locked-Down SAS 
Server}

Six types of SAS servers can be configured to run in a high-security locked-down mode: 
workspace, pooled workspace, stored process, batch, grid, and SAS/CONNECT. When 
a server is locked down, it can access only specified resources on the host file system. 
The server also cannot run or invoke a number of SAS language elements that access 
the host file system.

To enable SAS Add-In for Microsoft Office to access a locked-down server, the default 
starting point needs to be a location that is enabled for access. To learn how to change 
the default starting point, and to learn more about locked-down servers, see the \textit{SAS 
Intelligence Platform: Security Administration Guide}.

\section*{Configure SAS Add-In for Microsoft Office to Turn Off the Automatic Check 
for Updates Feature}

To turn off the automatic check for updates feature, follow these steps:
1 On the task bar, click **Tools ▶ Options**. In the **General** tab, deselect **Automatically check for updates**.

2 Click **OK**.

---

**Configure SAS Add-In for Microsoft Office to Hide the Check for Updates Option**

The **Check for Updates** option is located in **Help** menu on the Task Bar.

If necessary, you can hide the **Check for Updates** option. Follow these steps to hide the option:

1 Create a backup copy of your sas.officeaddin.dll.config if one exists. Otherwise, create a file called sas.officeaddin.dll.config in the SAS Add-In for Microsoft Office installation directory.

2 Add the following code to the sas.officeaddin.dll.config file:

```xml
<configuration>
    <assemblySettings>
```
<add key="CheckForUpdates" value="false"/>
</assemblySettings>
</configuration>

3 Save the file.

4 Open Excel. Select Help. Check for Updates should not appear.

If you hide the Check for Updates option using a configuration file, it disables both the automatic and the manual method of checking for updates.

---

**Tasks That Require Other SAS Software**

The SAS Add-In for Microsoft Office includes tasks that require the use of other SAS software. The SAS Forecast Studio tasks require the installation of the SAS Forecast Server software. The Rapid Predictive Modeler task requires the installation of the SAS Enterprise Miner software.

To run the tasks that use SAS Forecast Server or SAS Enterprise Miner, your role requires certain capabilities. The capabilities are defined in “Default Roles and Capabilities for the SAS Add-In for Microsoft Office” on page 32. Refer to the Time Series and Data Mining categories. Note that the Rapid Predictive Modeler task runs only on SAS 9.3 or 9.4 servers. The SAS Forecast Studio tasks run on SAS 9.2, 9.3, or 9.4 servers.

Beginning in SAS Add-In 7.1 for Microsoft Office, if you have SAS Studio installed on your local machine, you have access to additional tasks. For more information, see SAS Studio: Administrator's Guide.
Default Roles and Capabilities for the SAS Add-In for Microsoft Office

As described in the SAS Intelligence Platform: Security Administration Guide, you can assign users to roles to provide access to selected capabilities in the SAS Add-In for Microsoft Office.

Using SAS Management Console, as described in “Administering Roles and Capabilities” on page 10, you can assign users to roles, change the capabilities that are enabled by each role, and create new roles with unique sets of capabilities.

The User Manager in SAS Management Console provides three default roles for the SAS Add-In for Microsoft Office: Advanced, OLAP, and Analysis. The following table describes the capabilities that are assigned by default to these roles.

Usage notes for roles and capabilities:

- When you upgrade to a new release of the SAS Add-In for Microsoft Office, you need to manually replace all non-default roles and capabilities.

- In SAS Add-In 6.1 for Microsoft Office and later, you can access content in the SAS Visual Analytics software. Access to this content is determined by the roles and capabilities in the SAS Visual Analytics software, and not by the roles and capabilities in the SAS Add-In for Microsoft Office. To learn how to access content in SAS Visual Analytics, refer to the topic “Reference: Roles and Capabilities” in the document SAS Visual Analytics: Administration Guide.

- In the first maintenance release for SAS Add-In 6.1 for Microsoft Office, three new capabilities were added, which are identified with an asterisk (‘’) in the Capability column.

- In the SAS Add-In 7.1 for Microsoft Office, four new capabilities were added, which are identified with two asterisks (“”) in the Capability column.
### Table 3.3 Default Capabilities Assigned to Roles for the SAS Add-In for Microsoft Office

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced</th>
<th>OLAP</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open or Import Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>“Browse LASR Libraries”</td>
<td>Browse libraries that use the SASIOLA engine.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Open BID Content</td>
<td>Open BID indicators and dashboards in Microsoft Outlook only.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Cube from OLAP Server</td>
<td>Open an OLAP cube source into a document.</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Open Files from Local Computer</td>
<td>Open a file from the local file system. This is not a substitute for system security.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Open Time Series Data</td>
<td>Open OLAP cubes in Microsoft Outlook only.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Save or Distribute Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy and Paste SAS Server Content</td>
<td>Copy and paste from a file on the SAS Server or in a SAS library. This is not a substitute for system security.</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Email SAS Content</td>
<td>Send SAS content in a mail message, schedule a meeting, or assign a task from Microsoft Outlook only.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Output Data Location in SAS Tasks</td>
<td>Change the output data location for the SAS tasks that allow the user to specify an output location.</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Print SAS Content</td>
<td>Print SAS content from Microsoft Outlook only.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save SAS Content</td>
<td>Save SAS content to a file from Microsoft Outlook only.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save to SAS Folder</td>
<td>Save content to a SAS folder.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Send SAS Content to Microsoft Office</td>
<td>Send SAS content to Microsoft Office applications.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Content Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add or Modify Custom Code to SAS Tasks</td>
<td>Add or modify the custom code that runs before or after a SAS task.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td>Add or modify comments.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Options Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify All Options</td>
<td>Modify the options in the SAS Add-In Options dialog box.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Modify Email Options</td>
<td>Modify the current email options for new and existing documents.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Modify Metadata Authorizations</td>
<td>Modify the metadata authorization settings for folders.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify SAS Server Reference in Project or Document</td>
<td>Change the SAS server for all SAS content in the document.</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Modify Security Options</td>
<td>Modify the current security options for new and existing documents.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Tools and Help Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset Login</td>
<td>Remove the login from metadata associated with a server or library.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tools and Help Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access SAS Technical Support</td>
<td>Schedule when the SAS content in a document is refreshed. The user can also modify the scheduling options for a document.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access Unregistered Custom Tasks</td>
<td>Use custom tasks that are not registered in the metadata. By default, these custom tasks will work unless the task is restricted by an administrator.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create or Modify Schedules</td>
<td>Schedule when the SAS content in a document is refreshed. The user can also modify the scheduling options for a document.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Styles</td>
<td>Modify the style of the SAS output.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Data Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Compare Data</td>
<td>Create a report that compares two data sets or compares two variables within or across data sets.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy to SAS Server</td>
<td>Copy an active data source to SAS servers.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
<td>------</td>
<td>----------</td>
</tr>
<tr>
<td>Data Set Attributes</td>
<td>Create a report with the data set's creation date, location, and number of observations as well as the variable names, labels, types, and formats.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Edit Data Sets</td>
<td>Change the values and column properties of a data set in Microsoft Excel.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extract Data from SAS Visual Analytics Reports</td>
<td>Extract the data contained in a SAS Visual Analytics report.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Quick Stats</td>
<td>Show Quick Stats.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Random Sample</td>
<td>Create an output data set that contains a random sample of the rows in the input data set.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Rank</td>
<td>Compute ranks for one or more numeric variables across the observations of a SAS data set and sends the ranks as output to a new SAS data set.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Sort Data</td>
<td>Sort a data source by any of its columns.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Split Columns</td>
<td>Create an output data set by splitting the unique combination of values of the selected columns in the input data set into multiple columns.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Stack Columns</td>
<td>Create an output data set by restructuring selected columns in the input data set so that these columns are transposed into observations.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standardize Data</td>
<td>Standardize variables in a data source to a given mean and standard deviation. This task creates a new SAS data set that contains the standardized values.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transpose</td>
<td>Turn the selected columns of an input data source into the rows of an output data set.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot; Upload to LASR</td>
<td>Load a data source into a SAS LASR Analytics server.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Describe Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Characterize Data</td>
<td>Create a summary report, graphs, and frequency and univariate SAS data sets that describe the main characteristics of the data.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Distribution Analysis</td>
<td>Create a data summary. This task also provides information about the distribution of numeric variables and can be used to create a variety of plots.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>List Data</td>
<td>Print the observations in a SAS data set, using all or some of the variables. The user can create a variety of reports.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>List Report Wizard</td>
<td>Create detail or summary reports.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>One-Way Frequencies</td>
<td>Generate frequency tables from the data. The user can also use this task to perform binomial and chi-square tests.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Summary Statistics</td>
<td>Compute descriptive statistics for variables across all observations and within groups of observations. The user can also summarize data in a graphical display.</td>
<td>Advanced: X</td>
<td>OLAP: X</td>
<td>Analysis: X</td>
</tr>
<tr>
<td>Summary Tables</td>
<td>Display descriptive statistics in tabular format, using some or all of the variables in a data set. The user can create a variety of tables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Table Analysis</td>
<td>Generate crosstabulation tables, also known as contingency tables, from the data.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>Graph Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Area Plot</td>
<td>Create area, spline, step, or overlay plots that show the mathematical relationship between two variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Automatic Chart</td>
<td>Perform the Automatic Chart task.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bar Chart</td>
<td>Create vertical, horizontal, or three-dimensional bar charts that compare numeric values or statistics between different values of a chart variable.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Bar-Line Chart</td>
<td>Create a vertical bar chart with a line plot overlay. The line plot represents the value of a statistic that is calculated for one of the variables in the input data set.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
<td>------</td>
<td>----------</td>
</tr>
<tr>
<td>Box Plot</td>
<td>Create box plots, hi-lo charts, or hi-lo-close charts that display multiple summary statistics for some numeric variable across different values of a chart variable.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Bubble Plot</td>
<td>Create simple bubble plots. The bubbles are circles of varying proportions at data points that are plotted on the vertical and the horizontal axes.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Contour Plot</td>
<td>Create line, filled, pattern, or smooth plots that show the mathematical relationships between three numeric variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Donut Chart</td>
<td>Create simple or group charts that show the relative contribution of the parts to the whole. The data appears as wedge-shaped slices of a circle.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Line Plot</td>
<td>Create line, scatter, spline, needle, step, regression, smooth, STD, Lagrange interpolation, or overlay plots that show the mathematical relationships between variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Map Chart</td>
<td>Create a two-dimensional (choropleth) or three-dimensional (block and prism) color map that shows the variation in the value of a response variable for different geographical areas.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Pie Chart</td>
<td>Create simple, group, or stacked charts that represent the relative contribution of the parts to the whole. The data appears as wedge-shaped slices of a circle.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Radar Chart</td>
<td>Create radar (or star) charts that show the relative frequency of data measures in quality control or market research problems.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scatter Plot</td>
<td>Create two-dimensional scatter plots, three-dimensional scatter plots, or three-dimensional needle plots that show the relationships between two or three variables.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scatter Plot Matrix</td>
<td>Create a matrix of scatter plots.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show ODS Statistical Graph</td>
<td>Show ODS Statistical Graph from an SGD file.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surface Plot</td>
<td>Create three-dimensional wireframe plots, smooth plots, or gradient plots that show the mathematical relationships between three numeric variables.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tile Chart</td>
<td>Create a tile chart. Each unique category combination is represented by a rectangular tile whose size and color are determined by the response variables.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ANOVA Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linear Models</td>
<td>Analyze data within the framework of general linear models. This task uses the method of least squares to fit general linear models.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mixed Models</td>
<td>Fit a variety of mixed linear models to data and to use these fitted models to make statistical inferences about the data.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nonparametric One-Way ANOVA</td>
<td>Run nonparametric tests for location. The task also scales differences across a one-way classification and provides a standard analysis of variance on the raw data.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>One-Way ANOVA</td>
<td>Test for differences among the means of the levels and quantify the differences.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>t Test</td>
<td>Perform t-tests for one sample, two samples, and paired observations.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Regression Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Generalized Linear Models</td>
<td>Model data that is not normally distributed. This task can also model data for which the mean has been restricted to a range of values or data for which the variance is not constant.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Linear Regression</td>
<td>Perform linear regression analysis on multiple dependent and independent variables using a high-performance distributed environment.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logistic Regression</td>
<td>Investigate the relationship between discrete responses and a set of explanatory variables using a high-performance distributed environment.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linear Regression</td>
<td>Perform linear regression analysis on multiple dependent and independent variables.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logistic Regression</td>
<td>Investigate the relationship between discrete responses and a set of explanatory variables.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
</tr>
<tr>
<td>Nonlinear Regression</td>
<td>Produce least squares or weighted least squares estimates of the parameters of a nonlinear model.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Multivariate Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Canonical Correlation</td>
<td>Examine the relationship between a linear combination of a set of $X$ variables and a linear combination of a set of $Y$ variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cluster Analysis</td>
<td>Create hierarchical clusters of the observations in a SAS data set that contains either coordinate data or distance data.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Correlations</td>
<td>Determine the relationship between numeric variables. The relationship is described by calculating correlation coefficients for the variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Discriminant Analysis</td>
<td>Develop a discriminant criterion that can be used to classify the values of the quantitative variables into the groups defined by the classification variable.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Factor Analysis</td>
<td>Perform a variety of common factor and component analyses and rotations.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Principal Components</td>
<td>Examine relationships among several quantitative variables. This task can be used for summarizing data and detecting linear relationships.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Survival Analysis Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Life Tables</td>
<td>Compute nonparametric estimates of the survival distribution of data that might be right-censored due either to withdrawals or to termination of the study.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proportional Hazards</td>
<td>Perform regression analysis of survival data based on the Cox proportional hazards model.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CDF Plots</td>
<td>Plot the observed cumulative distribution function (CDF) of a variable.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Histograms</td>
<td>Compare the distribution of measurements from a process in statistical control to its specification limits.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>P-P Plots</td>
<td>Compare the empirical cumulative distribution function (ECDF) of a variable to a specified theoretical cumulative distribution function, such as the normal distribution.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Probability Plots</td>
<td>Compare ordered values of a variable to the percentiles of a specified theoretical distribution, such as the normal distribution.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q-Q Plots</td>
<td>Compare ordered values of a variable to the quantiles of a specified theoretical distribution, such as the normal distribution.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control Charts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Box Chart</td>
<td>Create a mean chart for the subgroup means. The task superimposes the box-and-whisker plots of the measurements for each subgroup onto the mean chart.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>c Chart</td>
<td>Create c charts for the numbers of nonconformities (defects) in the subgroup samples.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Individual Measurements Chart</td>
<td>Create control charts for the individual measurements and the moving ranges.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mean and Range Chart</td>
<td>Create mean and range charts for the subgroup means and the subgroup ranges.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mean and Standard Deviation Chart</td>
<td>Create mean and standard deviation charts for the subgroup means and the subgroup standard deviations.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>np Chart</td>
<td>Create np charts for the numbers of nonconformities (defects) in the subgroup samples.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>p Chart</strong></td>
<td>Create p charts for the proportions of nonconforming (defective) items in the subgroup samples.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>u Chart</strong></td>
<td>Create u charts for the numbers of nonconformities (defects) per inspection unit in the subgroup samples that contain arbitrary numbers of units.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Pareto Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pareto Chart</td>
<td>Create a chart that displays the relative frequency of problems in a process as bars. Pareto charts help the user identify the problems that deserve the most attention.</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Time Series Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ARIMA Modeling and Forecasting</td>
<td>Analyze and forecast equally spaced univariate time series data, transfer function data, and intervention data by using the ARIMA or ARMA model.</td>
<td>X X X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basic Forecasting</td>
<td>Generate forecasts for many time series in one step. This task uses extrapolative forecasting methods where the forecasts for a series are functions only of time and past values.</td>
<td>X X X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Time Series Data</td>
<td>Convert transactional data into fixed-interval time series. Transactional data is time-stamped data that is collected over time with irregular or varied frequency.</td>
<td>X X X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forecast Studio Create Project</td>
<td>Specify the forecasting variables, choose whether to forecast your data hierarchically, and specify the forecast horizon for a new SAS Forecast Studio project.</td>
<td>X</td>
<td>OLAP</td>
<td>Analysis</td>
</tr>
<tr>
<td>Forecast Studio Open Project</td>
<td>Open the selected series from an existing SAS Forecast Studio project and specify how to display the results.</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Forecast Studio Override Project</td>
<td>Submit overrides for the forecast data in an existing SAS Forecast Studio project.</td>
<td>X</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Prepare Time Series Data</td>
<td>Prepare data for analysis by other time series tasks. It can also be used to perform generic transformations on data that is intended for use in any other tasks.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Regression Analysis of Panel Data</td>
<td>Estimate and forecast linear regression models for time series data when the errors are not independent through time or the error variance is not constant.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Regression Analysis with Autoregressive Errors</td>
<td>Estimate and forecast linear regression models for time series data when the errors are not independent through time or the error variance is not constant.</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Data Mining Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Model Scoring</td>
<td>Score a data set against an existing SAS Enterprise Miner predictive model.</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
<td>------</td>
<td>----------</td>
</tr>
<tr>
<td>Rapid Predictive Modeler</td>
<td>Create a predictive model using SAS Enterprise Miner procedures.</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Recency, Frequency, and Monetary Analysis</td>
<td>Identify existing customers who might respond to a new campaign or product offer.</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

### Registering Custom Tasks as Capabilities in the SAS Add-In for Microsoft Office

#### Overview

Custom add-in tasks are .NET assemblies (DLL files) that you create, deploy, register, and execute from the SAS ribbon in Microsoft Office applications.

To provide access to custom tasks based on the job responsibilities in your organization, you can register custom tasks as capabilities, assign the capabilities to roles, and assign users to roles.

The process of creating, deploying, registering, and executing custom tasks as capabilities in the SAS Add-In for Microsoft Office is similar to the process that is used in SAS Enterprise Guide.

#### Create Custom Tasks

To create custom tasks, you develop Windows executables and package them as .NET assemblies. It is convenient to assemble multiple tasks in a single .NET assembly so that you can share code and implementation among the tasks. For additional information, sample DLLs, and sample executable source files, see *Creating Custom*
Deploy Custom Tasks

You can deploy custom tasks to computers that run the SAS Add-In for Microsoft Office in two ways, using drop-in deployment or add-in deployment. Drop-in deployment copies .NET assemblies into specific local directories that are recognized by the SAS Add-In for Microsoft Office. Custom tasks in drop-in directories are automatically registered (made available for execution) the next time the user starts a Microsoft Office application.

Add-in deployment copies .NET assemblies into any local directory. You then identify those directories for use in the SAS Add-In for Microsoft Office using the Add-In Manager in SAS Enterprise Guide. Deployment registration makes the custom tasks available for execution from the SAS ribbon in Microsoft Office applications.

When you deploy your custom tasks, make sure that you include any dependent assemblies that are referenced by those tasks. At the same time, make sure that you do not include any dependent assemblies that are provided by the SAS Add-In for Microsoft Office or by SAS Enterprise Guide.

Follow these steps to use the Add-In Manager:

1. Copy the .NET assembly into one of the following directories:
   - C:\ProgramFiles\SASHome\Add-InForMicrosoftOffice\version\Custom
   - %appdata%\SAS\Add-InForMicrosoftOffice\version\Custom
     %appdata% is the Microsoft Windows environment variable that maps to a user account. Repeat the copy in other user accounts if multiple users run the SAS Add-In for Microsoft Office on the same host.
   - %appdata%\SAS\SharedSettings\version\Custom
     Use this method to deploy custom tasks to specified user accounts, using a shared directory that is accessed by both the SAS Add-In for Microsoft Office and SAS Enterprise Guide.
2 Start or restart a Microsoft Office application to register the custom tasks and make them available for testing.

Follow these steps to use add-in deployment:

1 Copy the .NET assembly into any local directory.

2 Start SAS Enterprise Guide and open the Add-In Manager. Select **Tools** ➤ **Add-In** ➤ **Add-In Manager**.

3 In the Add-In Manager dialog box, select **Browse**.

4 Navigate to the directory where you stored your .NET assembly.

5 Click **Open** to display the names of the custom tasks in the assembly.

6 Click **OK** to accept the custom tasks and register them in SAS Enterprise Guide.

7 Test the new custom tasks in a Microsoft Office application.

**Register Custom Tasks as Capabilities**

In order for SAS Enterprise Guide Explorer to register tasks for use in SAS Add-In for Microsoft Office, the explorer must be started from the SAS Add-In for Microsoft Office installation folder. Launch the SAS Enterprise Guide Explorer by executing the file SEGExplorer.exe found in the SAS Add-In for Microsoft Office installation folder, which is usually `C:\Program Files\SASHome\Add-InForMicrosoftOffice\version\SEGExplorer.exe`.

Follow these steps to register custom tasks as capabilities:


2 In Explorer, select **Tools** ➤ **Task Import Wizard**.

3 In the first page of the Task Import Wizard, you see your current metadata profile connection. If you need to connect with a different profile, click **Cancel** to close the
wizard and select File  Manage Profiles. After you change your profile, click Close. Start the Task Import Wizard.

4 In the second page of the Task Import Wizard, select All known locations on this computer. Selecting this option ensures that the custom tasks that you registered with the Add-In Manager is registered in metadata by Task Import Wizard.

To find custom tasks, the Task Import Wizard looks for the file AddInRegistry.xml, which is created by the Add-In Manager. If you selected Common registry in the Add-In Manager, then the path to AddInRegistry.xml is C:\ProgramData\SAS\BIClientTasks\4\AddInRegistry. If you selected User registry in the Add-In Manager, then the path to AddInRegistry.xml is C:\Users\your-user-ID\AppData\Roaming\SAS\BIClientTasks\4\AddInRegistry.

5 Select tasks to receive metadata. Click Finish in the sixth wizard page to create metadata.

If you are unable to create metadata, then you might need to install the package named SAS Add-In for Microsoft Office Server Data on the host that contains your current metadata repository.

Apply Custom-Task Capabilities to Roles

Follow these steps to apply custom-task capabilities to roles:

1 In SAS Management Console, open the User Manager.

2 To create a new role for your custom-task capabilities, right-click in the User Manager and select New  Role.

3 To add a custom-task capability to an existing role, double-click an Add-In for Microsoft Office role.

4 In the role properties window, click the Capabilities tab.

5 In the Capabilities tab, expand the Plug-Ins branch in the tree view.

6 Click the custom-task capabilities that you want to add to that role.
7 Click **OK**.

The custom-task capabilities will be applied to the role the next time affected users initialize a Microsoft Office application.

---

**Library Access for the SAS Add-In for Microsoft Office**

If the SAS add-in attempts to write data to a table on the SAS Metadata Server, and the structure of the updated table is different, the metadata is not updated. For this reason, it is advisable to regulate Write access to registered tables from Excel, Word, and PowerPoint. Read access, for the purposes of querying SAS OLAP cubes using Excel, requires no special consideration.

Access to registered libraries is determined in part by the library access method. By default, all libraries that are registered on the SAS Metadata Server are Read-only. SAS Add-In for Microsoft Office users cannot create, add, or delete tables. The default library access method can be changed, as described in “Review Library Access in SAS Enterprise Guide” on page 114.

**CAUTION!** To maintain referential integrity on the SAS Metadata Server, it is advisable to inform the SAS Add-In for Microsoft Office users about their permissions to access registered libraries.
SAS OLAP Cube Studio Overview for Administrators

SAS OLAP Cube Studio is used to build, edit, and tune OLAP cubes. To build a cube, the application generates metadata and a SAS program. It then submits the program for execution on a SAS Workspace Server. The SAS Workspace Server builds the cube and stores the result in a physical location that can be accessed by a SAS OLAP Server.

When a cube becomes available on a SAS OLAP Server, it is queried by users working with OLAP clients. These clients can include SAS Web Report Studio, SAS Web OLAP Viewer, and SAS Enterprise Guide. The cube viewers submit queries to the SAS OLAP Server in the industry-standard MDX query language. The SAS OLAP Server responds to queries by delivering result sets to the cube viewers for display.
To configure your enterprise for SAS OLAP Cube Studio, perform the following tasks:

- Install and register SAS OLAP Servers and SAS Workspace Servers.
- Create libraries for cubes and cube data.
- Set up users, groups, and roles for OLAP cube builds, updates, and queries.
- Use the OLAP Server Monitor and Server Manager plug-ins in SAS Management Console to monitor, control, and tune SAS OLAP Servers.

For information about the administration of SAS OLAP Servers, see “Administering SAS OLAP Servers” in SAS Intelligence Platform: Application Server Administration Guide.

---

**Setting Up the SAS Intelligence Platform for SAS OLAP Cube Studio**

Set up the SAS Intelligence Platform as follows to use SAS OLAP Cube Studio:

1. Install, configure, and start a host that runs both a SAS Workspace Server and a SAS OLAP Server. This step generally occurs at initial deployment, as described in the SAS Intelligence Platform: Installation and Configuration Guide.

2. Define libraries and data sources, as described in the SAS Intelligence Platform: Data Administration Guide.

3. Define access controls for libraries, users of SAS OLAP Cube Studio, and users of cube viewers. After you build a cube, you can apply access controls within the cube, including member–level access controls, as described in the SAS Intelligence Platform: Security Administration Guide.

4. Set up connection profiles and roles for OLAP users, as described in Chapter 2, “Common Elements,” on page 5.
Understanding the Configuration of SAS OLAP Cube Studio

The following administrative and configuration files for SAS OLAP Cube Studio are located on each client:

olapa.ini
contains configuration settings for SAS OLAP Cube Studio. The default storage location is \SAS\SASOLAPCubeStudio\version.

CubeStudioDefaults.txt
contains the user properties for SAS OLAP Cube Studio. The default storage location is C:\Documents and Settings\UserID\Application Data\SAS\SASOLAPCubeStudio\version.

Log files
C:\Documents and Settings\userID\Application Data\SAS\SASOLAPCubeStudio

Log files in the Vista operating environment
C:\Users\userID\AppData\Roaming\SAS\SASOLAPCubeStudio

Administering OLAP Sessions and Queries

The SAS OLAP Server Monitor plug-in for SAS Management Console displays information about client connections to SAS OLAP Servers. Connecting to one of those servers displays a list of active queries on that server. You can close selected sessions or queries. For more information about the SAS OLAP Server Monitor, see “Administering SAS OLAP Servers” in SAS Intelligence Platform: Application Server Administration Guide. Also see the SAS OLAP Server Monitor Help.
Administering SAS OLAP Servers

SAS OLAP Server administration takes place in the Server Manager and the SAS OLAP Server Monitor plug-ins in SAS Management Console. Certain server control functions are also available from SAS OLAP Cube Studio.

Use the Server Manager plug-in to set options on SAS OLAP Servers. Open the server's properties window, select **Options**, and select **Advanced Options**.

Use the Server Manager or the SAS OLAP Server Monitor to stop, pause, and quiesce SAS OLAP Servers in support of cube builds and cube updates. For more information about stopping and starting servers, see the *SAS Intelligence Platform: System Administration Guide*. 
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Administering SAS Data Integration Studio</td>
<td>59</td>
</tr>
<tr>
<td>Connecting to SAS Servers</td>
<td>61</td>
</tr>
<tr>
<td>Overview of SAS Server Connections in SAS</td>
<td>61</td>
</tr>
<tr>
<td>Data Integration Studio</td>
<td>61</td>
</tr>
<tr>
<td>Connect to a SAS Metadata Server</td>
<td>61</td>
</tr>
<tr>
<td>Connect to a Workspace Server</td>
<td>61</td>
</tr>
<tr>
<td>Set Grid Server Options</td>
<td>62</td>
</tr>
<tr>
<td>Connecting to Data Servers</td>
<td>63</td>
</tr>
<tr>
<td>About Scheduling Servers</td>
<td>64</td>
</tr>
<tr>
<td>Setting Up Change Management</td>
<td>64</td>
</tr>
<tr>
<td>Overview of Change Management</td>
<td>64</td>
</tr>
<tr>
<td>Create a Change-Managed Folder in the Folders Tree</td>
<td>66</td>
</tr>
<tr>
<td>Create a Folder Structure for Project</td>
<td>67</td>
</tr>
<tr>
<td>Repositories on the File System</td>
<td>67</td>
</tr>
<tr>
<td>Create a Project Repository for Each User</td>
<td>67</td>
</tr>
<tr>
<td>Setting Up Multi-Tier Environments</td>
<td>68</td>
</tr>
<tr>
<td>Access Remote Data</td>
<td>68</td>
</tr>
<tr>
<td>Process Remote Jobs</td>
<td>72</td>
</tr>
<tr>
<td>Administering Message Queues</td>
<td>74</td>
</tr>
<tr>
<td>What Are Message Queues?</td>
<td>74</td>
</tr>
</tbody>
</table>
About the Third-Party Messaging Software ........................................ 74
About Message Queues in the SAS Intelligence Platform ......................... 75
Requirements for Message Queues .................................................. 75
Install and Configure the Microsoft MSMQ Message Queue Software ........ 76
Install and Configure the IBM WebSphere MQ Message Queue Software .... 77
Create a Message Queue Polling Server for WebSphere MQ Message Queue Software .................................................. 77
Create a Message Queue Server and Register Queues ......................... 78
Manage Queues and Queue Managers .......................................... 78

Configuring the SAS Workspace Server to Enable the Bulk Loading of Data .................................................. 79
Setting X Command Options to Run Perl or Shell Scripts ....................... 81
Setting Up the SAS Data Quality Server Software .......................... 81
  Overview of SAS Data Quality Server Software ................................ 81
  About the Data Quality Configuration ........................................ 82
  Test the SAS Data Quality Server Software .................................. 83
  Register a New DataFlux Data Management Server .......................... 84
  Download Locales ................................................................. 85
  Create Schemes ................................................................. 86
  Set Data Quality Options for SAS Data Integration Studio ................ 87

Redirecting Output and Logging Information to a File ....................... 87

Enabling Status Code Handling ................................................. 88
  Overview of Status Code Handling .......................................... 88
  Support the Email Action .................................................. 89
  Support the Custom Action ................................................ 89

Using FTP or HTTP Servers to Access External Files ......................... 90
Overview of Administering SAS Data Integration Studio

SAS Data Integration Studio is a visual design tool that enables data integration specialists to consolidate and manage enterprise data from a variety of source systems, applications, and technologies. This software enables these users to create process flows that accomplish the following tasks:

- extract, transform, and load (ETL) data for use in data warehouses and data marts
- cleanse, migrate, synchronize, replicate, and promote data for applications and business services

SAS Data Integration Studio enables users to integrate information from any platform that is accessible to SAS and from any format that is accessible to SAS.

The following table introduces the administrative tasks that are associated with SAS Data Integration Studio:

Table 5.1 Administrative Tasks for SAS Data Integration Studio

<table>
<thead>
<tr>
<th>Administrative Task</th>
<th>Purpose of Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to SAS servers</td>
<td>Make sure that your data integration specialists can connect to the necessary SAS servers. For example, each user must be able to connect to the SAS Metadata Server to register data sources and other objects.</td>
</tr>
<tr>
<td>Connect to data servers</td>
<td>Make sure that your data integration specialists can connect to the necessary data servers.</td>
</tr>
<tr>
<td>Administrative Task</td>
<td>Purpose of Task</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set up change management</td>
<td>Set up a change-managed folder in the Folders tree, if desired. This enables individual users to check objects out of a foundation repository and place them in a private repository. The private repository, called a project repository, provides a location where the users can test changes.</td>
</tr>
<tr>
<td>Set up multi-tier environments</td>
<td>Set up SAS Data Integration Studio to work in a multi-tier configuration. Almost all configurations have multiple tiers.</td>
</tr>
<tr>
<td>Administer message queues</td>
<td>Install third-party message queue software, define queues, and register queues for inter-process communication.</td>
</tr>
<tr>
<td>Configure stored process servers for the deployment of stored process jobs or web service jobs</td>
<td>Install SAS Stored Process Servers as needed for jobs that are deployed as stored processes or web services that generate XML output.</td>
</tr>
<tr>
<td>Configure the SAS Workspace Server to enable the bulk loading of data</td>
<td>Enable SAS Workspace Servers to execute external commands so that jobs can rapidly load data into a DBMS.</td>
</tr>
<tr>
<td>Test the Platform Computing Scheduling Server</td>
<td>Test the servers (and clients) that enable your users to schedule sets of SAS Data Integration Studio jobs.</td>
</tr>
<tr>
<td>Set up the SAS Data Quality Server software</td>
<td>Set up the infrastructure necessary for your users to use data-quality transformations.</td>
</tr>
<tr>
<td>Redirect output and logging information to a file</td>
<td>Specify alternative destinations for the SAS log and SAS output.</td>
</tr>
<tr>
<td>Configure status code handling</td>
<td>Configure jobs to send status codes via email, to files, or by executing a SAS program.</td>
</tr>
<tr>
<td>Use FTP or HTTP servers to access external files</td>
<td>Install a content server to access external files.</td>
</tr>
</tbody>
</table>
Connecting to SAS Servers

Overview of SAS Server Connections in SAS Data Integration Studio

SAS Data Integration Studio users connect to a SAS Metadata Server and a SAS Workspace Server. The SAS Workspace Server might be part of a load-balancing grid configuration.

Connect to a SAS Metadata Server

At initialization time, SAS Data Integration Studio users select a connection profile that connects the desktop application to a SAS Metadata Server. The administrator might need to help users create one or more connection profiles, as described in “Administering Connection Profiles for Desktop Applications” on page 6.

Connect to a Workspace Server

When you execute a job in SAS Data Integration Studio, the application submits generated SAS code to a SAS Workspace Server, which executes the code. Therefore, it is imperative that an object spawner is running and that SAS Data Integration Studio is able to use the spawner to start a SAS Workspace Server. To test a connection to a SAS Workspace Server, follow these steps:

1. Select Tools ▶ Options.
2. In the Options dialog box, select the Server tab.
3. Select from the list the name of the SAS Application Server to which the SAS Workspace Server belongs.
4. Click Test Connection. You might be prompted for a user name and password. If you are, enter credentials that enable you to be authenticated on the host where the
SAS Workspace Server is running. If all goes well, you see an Information dialog box that says, “Connection to the server was successful”.

Set Grid Server Options

Grid computing is implemented in the separately licensed SAS Grid Manager software. SAS Grid Manager runs grid-enabled jobs on multiple servers. The grid configuration consists of a logical SAS grid server that distributes processing tasks. In addition, the configuration includes any number of SAS Workspace Servers that execute distributed tasks, a SAS Grid Monitor server, and a Grid Monitor plug-in for SAS Management Console. The distribution of tasks across the grid is determined by a grid workload specification that you create and register in SAS Management Console.

The following steps are performed on the global *Options* tab in SAS Data Integration Studio. Before you can perform these tasks, a SAS grid server and a grid workload specification must be registered in SAS Management Console. For more information about these tasks, see *Grid Computing in SAS*.

To select a SAS grid server and specify related options for SAS Data Integration Studio jobs, follow these steps:

1. In SAS Data Integration Studio, select **Tools ▶ Options** from the menu bar and select the **SAS Server** tab.
2. In the **Grid workload specification** box, select the specification that you want to apply to your grid jobs.
3. In the **Signon options** box, specify the options that you want to apply at the start of each grid computing session.
4. In the **Number of signon entries** box, enter the number of times that you want to reconnect to the grid after errors. The default value is three.
5. Select the **Code Generation** tab.
Jobs executed on a grid are executed in parallel. SAS Data Integration Studio uses a set of macros to enable parallel processing. To enable parallel processing for all new jobs, select the **Enable parallel processing macros** check box.

Alternatively, you can enable these macros for individual jobs. You can select **YES** in the **Enable parallel processing macros** option on the **Options** tab of the properties window for an individual job. Also, simply including a Loop transformation in a job enables parallel processing for that job.

Consider setting options for concurrent processes based on the hosts that make up your grid.

Click **OK** to save your changes.

---

**Connecting to Data Servers**

Establish that your users can connect to the SAS Metadata Server and the system’s SAS Workspace Servers. Then ensure that users can access the input data sources to SAS Data Integration Studio jobs. Here are some examples of these sources:

- DB2 tables
- Sybase tables
- Teradata tables
- ODBC data sources
- Oracle tables
- SAS data sets
- SAS Scalable Performance Data Engine tables

The general procedure for connecting to data servers is as follows:

- Register your data sources. See the SAS *Intelligence Platform: Data Administration Guide*. 

---
View data sources in SAS Data Integration Studio.

To determine whether your data integration developers are able to read data from a particular data server, follow these steps:

1. In the Inventory tree, expand the **Table** node.
2. Right-click a data source and select **Open** to display the View Data window.

### About Scheduling Servers

Data integration specialists can create flows, which are sets of jobs that have been deployed for scheduling. Each job within a flow can be scheduled to execute as follows:

- at a certain time
- as determined by the state of a file (existence, age, or content)
- as determined by the state of a job or flow (completion)

For information about installing, testing and using scheduling services, refer to *Scheduling in SAS*.

### Setting Up Change Management

#### Overview of Change Management

The change management feature enables a team of SAS Data Integration Studio users to work simultaneously with a set of related metadata and avoid overwriting each other's changes. With change management, most users are restricted from adding or updating the metadata in a change-managed folder in the Folders tree. Authorized users, however, can add new metadata objects and check them in to the change-managed folder. They can also check out metadata objects from the change-managed folder in order to update them. The objects are locked so that no one else can update them as
long as the objects are checked out. When the users are ready, they check in the objects to the change-managed folder, and the lock is released.

If a user is authorized to work in a change-managed folder, a Checkouts tree is added to his or her desktop in SAS Data Integration Studio. The Checkouts tree displays metadata in the user's project repository, which is an individual work area or play pen. Typically, each user has his or her own project repository. If more than one user were to connect to the same project repository, the users might overwrite each other's changes.

To set up change management, follow these steps:

1. Register SAS Data Integration Studio users on the metadata server if they are not registered already. For more information, see Chapter 9, “Administering SAS Management Console,” on page 157.

2. (Optional) Create a custom group and add the SAS Data Integration Studio users who are working with change management as members of this group. For example, you could create a group called Change Management Group. For more information, see Chapter 9, “Administering SAS Management Console,” on page 157. Creating this custom group makes it easier to specify metadata permissions for the change-managed folder. You can specify permissions for the change management group rather than individual users.

3. Create a change-managed folder in the Folders tree. For more information, see the next section.

4. Create a folder structure for project repositories on the file system.

5. Create a project repository for each user who works in the change-managed folder.

6. Have each user create a connection profile, connect to the metadata server, and select his or her project repository. To verify that change management is working, you might want to have each user check out a metadata object and check it back in. For more information about these tasks, see “Administering Connection Profiles for Desktop Applications” on page 6.
Create a Change-Managed Folder in the Folders Tree

Follow these steps to add a new folder in the Folders tree. Specify a special set of metadata permissions for that folder. This task is easier if you have already created a custom group and added the SAS Data Integration Studio users who work with change management as members of this group.

1. In SAS Management Console, right-click a parent folder in the Folders tree, such as SAS Folders, and select New Folder.

2. Specify a name for the new folder and click Finish to add the folder to the Folders tree.

3. Right-click the new folder and select Properties.

4. In the properties window, click the Authorization tab.

5. For users or groups who should not be authorized to work in the new folder, grant ReadMetadata permission, and deny other permissions.

6. For users or groups who should be authorized to work in the new folder, grant ReadMetadata and CheckInMetadata permissions, and deny other permissions.

7. The standard set of privileges that enable you to work in a change-managed folder do not enable you to perform administrative tasks such as the following:
   - deploy a job for scheduling
   - deploy a job as a stored process
   - create a web service from a stored process
   - clear a project repository that you do not own

For administrators who need to perform these tasks, grant WriteMetadata and WriteMemberMetadata permissions.
When you are finished specifying permissions, click **OK** to save your changes to the **Authorization** tab.

You have now created a change-managed folder in the Folders tree.

**Create a Folder Structure for Project Repositories on the File System**

On the computer where the SAS Metadata Server is installed, create a folder structure for project repositories on the file system.

Each subfolder under **Projects** contains the project repository for a user who is working with change management in SAS Data Integration Studio.

To create a folder structure for project repositories on the file system, follow these steps:

1. On the computer where the SAS Metadata Server is installed, go to the folder `SAS-installation-directory\Lev1\SASMeta\MetadataServer \MetadataRepositories`.

2. In the **MetadataRepositories** folder, a folder for the foundation repository is displayed. On the same level as the foundation folder, add a new folder called **Projects**.

3. Under the **Projects** folder, create a folder for each user who works with change management in SAS Data Integration Studio.

You are now ready to create project repositories for each user.

**Create a Project Repository for Each User**

Repeat these steps for each user who works in a change-managed folder. It is assumed that you have registered these users and have created an appropriate folder structure for project repositories.
1 In SAS Management Console, expand the Metadata Manager folder, and then expand the Active Server folder.

2 Right-click the Project Repositories folder and select New Project Repository.

3 In the Create New Project Repository Wizard, select a SAS Data Integration Studio user who works in a change-managed folder. Click Next.

4 Enter a name and an optional description of the project repository. Click Next.

5 Specify the full physical path to a project repository folder. Typically, you make no other changes. Click Next.

6 On the last page of the wizard, click Finish.

An icon that represents the new repository is displayed under the Project Repositories folder.

After you create a project repository for a user, ask that user to create a connection profile. Use that profile to connect to a SAS Metadata Server, and select his or her project repository. You might have each user check out a metadata object and check it back in. This verifies that change management is operational.

---

**Setting Up Multi-Tier Environments**

**Access Remote Data**

**Overview of Remote Data Access**

The procedures in this section explain how to enable your SAS Data Integration Studio users to access data on a host that is remote from the SAS Workspace Server. This is done by installing SAS/CONNECT software on the SAS Workspace Server host and then configuring a SAS/CONNECT server on the remote host.

In order to access data on a host that is remote from your SAS Workspace Server, you must run SAS/CONNECT software. Run SAS/CONNECT on your SAS Workspace
Server machine (the local host), and on the machine with your data (the remote host). To understand this setup, consider the following figure:

![Diagram of the network setup](image)

In this network, we have three machines:
- the machine running the SAS Workspace Server and the SAS Metadata Server (the local host)
- a separate machine with data (the remote host)
- the SAS Data Integration Studio client machine

**Set Up a Local Host**

These procedures assume that SAS software has been installed on the local host machine. Furthermore, the local host machine needs to be set up as follows:
- The local host runs the SAS Workspace Server.
- The SAS Application Server of which the SAS Workspace Server is a component needs to be set as the default SAS Application Server for SAS Data Integration
Studio. This is done from the SAS Data Integration Studio client machine. See “Connect to a Workspace Server” on page 61.

- SAS/CONNECT software needs to be installed on the local host machine. This should have been done at installation time.

**Set Up a Remote Host**

Install and configure Base SAS and SAS/CONNECT software on the remote host. Follow the instructions in the *SAS Intelligence Platform: Installation and Configuration Guide*.

The installation process creates the server initialization script ConnectServer.bat. Use this script to invoke the SAS/CONNECT spawner as a service. The spawner starts SAS/CONNECT sessions as needed. You can find the files in the `SAS-installation-directory\Lev1\appServer\ConnectServer`.

You can make other configuration changes to the remote host from any machine running SAS Management Console.

In the next two sections, you define the SAS/CONNECT server and your SAS library in metadata.

**Set Up a Remote SAS/CONNECT Server**

On the remote host, use the SAS Deployment Wizard to define a second and new SAS Application Server that contains a SAS/CONNECT server and a SAS Workspace Server. The new servers are necessary because the local SAS Application Server does not have access to the remote library. For information about using the SAS Deployment Wizard to create new a SAS Application Server, see the *SAS Intelligence Platform: Application Server Administration Guide*.

**Define SAS Libraries**

From SAS Management Console, define one or more SAS libraries on the remote host machine. The libraries contain the tables that are accessed by SAS Data Integration Studio. These instructions are appropriate for SAS data sets:

1. Expand **Data Library Manager**.
2. Right-click **Libraries** and select **New Library**.
3 Use the New Library Wizard to define the library. Assign the new library to the new SAS Application Server on the remote host.

**Set Up a SAS Data Integration Studio Client Machine**

From the SAS Data Integration Studio client machine, you need to do the following:

1 define a default SAS Application Server
2 define tables in the metadata for the remote host
3 test your setup

In addition, if you have created a new authentication domain for your remote server, you need to create new logins for your SAS Data Integration Studio users. These logins must contain a user ID and password that are valid on the SAS/CONNECT host.

**Register Source Tables on the Remote Host**

To identify in metadata the tables on the remote host, follow these steps:

1 In SAS Data Integration Studio, select File ➤ Register Tables.
2 In the Sources folder, select a source, such as SAS, and click Next.
3 In the SAS Library box, select the library that you created earlier.
4 Verify or edit the library details.
5 Consider selecting the DBMS check boxes to enable case sensitivity or special characters for the source tables, and then click Next.
6 Select the tables to register in metadata and click Next.
7 Review your entries, and then click Finish.

**Test Your Setup Using View Data**

To test your setup, follow these steps:
1 In SAS Data Integration Studio, select the **Inventory** tab.

2 In the **Inventory** tab, expand the **Library** node.

3 Right-click a table in the library and select **View Data**.

This test verifies that you can access your remote library.

### Process Remote Jobs

**Overview of Remote Job Processing**

You might want to process one or more SAS Data Integration Studio jobs. There might be a large amount of data on a remote machine to which you save your results. In such an instance, it might be more efficient to move the job itself to the remote machine. A multi-tiered configuration can make that possible.
To move a job to a remote machine, you need to have a SAS Workspace Server on the remote host. The following software must be installed on the remote host machine:

- Base SAS software
- SAS Integration Technologies software

If you have not already installed this software, follow the instructions in the *SAS Intelligence Platform: Installation and Configuration Guide*. After installation, run the SAS Deployment Wizard to configure the following:

- SAS object spawner
- SAS Workspace Server
- SAS DATA step batch server

**Select Your Application Server and Workspace Server**

To run SAS Data Integration Studio jobs on a remote host, open SAS Data Integration Studio and select **Tools ▶ Options ▶ SAS Server**. Select the remote SAS Application Server, and then click **OK**.

**Register Your Batch Job Deployment Directory**

Batch jobs run through the Platform Scheduler, as configured through the Schedule Manager.

To register the directory for your batch jobs, follow these steps:

1. Create the directory on the specified host.
2. In SAS Management Console, expand the **Schedule Manager** and select **Deployment Directories**.
3. With the name of the new SAS Application Server selected, select **New**.
4. In the New Directory window, enter a directory name and path, and then click **OK**.

**Deploy a Job Remotely Using SAS Data Integration Studio**

To test your remote job setup, follow these steps:
1 Start SAS Data Integration Studio.

2 In the **Inventory** tab, expand **Jobs**.

3 Right-click the job you want to deploy and select **Scheduling ▶ Deploy**.

4 In the Deploy a job for scheduling window, select a batch server and change the name, deployment directory, and job location, as necessary.

5 Click **OK** to deploy the job.

The deployed code is automatically copied to the remote host and is ready for scheduling or running at any time.

---

**Administering Message Queues**

**What Are Message Queues?**

Message queues are collections of data objects that enable asynchronous communication between processes. One application writes a message to a queue. Another application reads messages from the queue to begin the next step in a process. Verification processes guarantee that all messages are transmitted without error.

Queue managers handle message transmission and verification.

**About the Third-Party Messaging Software**

Fundamental message queue technology is provided in the following third–party software:

- Microsoft MSMQ
- IBM WebSphere MQ

You need to install and configure at least one messaging software application before you register metadata and run SAS messaging jobs.
About Message Queues in the SAS Intelligence Platform

In the SAS Intelligence Platform, you register metadata for queues and queue managers by using SAS Management Console after you install and configure third-party messaging software.

After you register metadata, you use the following transformations to create messaging jobs in SAS Data Integration Studio:

- Microsoft Queue Reader
- Microsoft Queue Writer
- WebSphere Queue Reader
- WebSphere Queue Writer

SAS Data Integration Studio also enables impact analysis and reverse impact analysis on queues, which you can use to track data flow into and out of queues.

The following data can be written to message queues using the queue writer transformation:

- text of length up to 32,767 bytes
- rows from SAS tables, one row per message
- external files

The queue reader transformation can be configured to read a specified number of rows from the message queue.

Requirements for Message Queues

To implement message queuing, you need to install and configure Microsoft MSMQ or WebSphere MQ. Start the installation process by downloading and installing third-party software on specified SAS Application Servers. In general you can plan to install a queue manager on each host that runs a SAS Workspace Server that runs message
Install and Configure the Microsoft MSMQ Message Queue Software

To install the MSMQ software on a SAS Workspace Server host that runs message queue jobs, follow these steps:

1. Ensure that the host meets the requirements for message queues, as described in “Requirements for Message Queues” on page 75.

2. In Windows, select Add or Remove Programs.

3. In the shortcut bar of the Add or Remove Programs window, select Add or Remove Windows Components, which opens the Windows Components Wizard.

4. In the Windows Components Wizard, select the Message queuing check box and click the Details button, which displays the Message queuing dialog box.

5. In the Message queuing dialog box, select all four subcomponent check boxes, and then click OK to return to the Windows Components Wizard.

6. Click Next to install the MSMQ software, and then close the Windows Components Wizard.

7. Use the MSMQ software to create the queues and queue managers that are required on this particular host. You need to create at least one queue for each queue manager. The same object names are used in SAS, so you might want to include the host name as part of the object names.

8. Use the Microsoft MSMQ software to start the queue managers.

9. Use SAS Management Console to register metadata for queues and queue managers, as described in Chapter 5, “Administering SAS Data Integration Studio,” on page 57.
Install and Configure the IBM WebSphere MQ Message Queue Software

To install and configure the WebSphere MQ software, follow these steps:

1. Download the software and documentation. Start with the following website: http://www-306.ibm.com/software/integration/wmq/index.html. Work with installation representatives from IBM and SAS as needed. At minimum, you need to install the WebSphere MQ Client software on all SAS Workspace Server hosts that run message queue jobs. Make sure that you meet the requirements for message queuing that are specified in “Administering Message Queues” on page 74.

   Note that if you install only the WebSphere MQ Client software, then you need to configure the environment variable MQSERVER to communicate with the WebSphere MQ Server software.

2. Use the WebSphere MQ software to create queues and queue managers on their respective hosts. For each queue manager, you need to define at least one queue. For reference in SAS, you might want to include the machine name in the names of the queue managers.

3. Use the WebSphere MQ software to start the queue managers on their respective hosts.

4. Use SAS Management Console to register metadata for queues and queue managers, as described in the next section.

Create a Message Queue Polling Server for WebSphere MQ Message Queue Software

If your site uses the WebSphere MQ (MQSeries) or WebSphere MQ Client (MQSeries C) from IBM, you can use SAS Message Queue Polling Servers. The servers can monitor message queues, manage messages, and trigger the execution of SAS programs in response to messages. The implementation process involves the creation of a queue manager, a queue polling server, a queue reader job, and a SAS program
that interprets messages. The implementation process is described in detail in *Application Messaging with SAS*.

**Create a Message Queue Server and Register Queues**

To register metadata for a queue and a queue manager, follow these steps:

1. In SAS Management Console, right-click **Server Manager** and select **New Server**.
2. In the New Server Manager, under **Queue Managers**, select either **MSMQ Queue Manager** or **WebSphere Queue Manager** and click **Next**.
3. Enter the exact name as it is defined in the third-party messaging software for the new queue manager. The names are case-sensitive.
4. Enter a description, and then click **Next**.
5. Select queues and folders, and then click **Next**.
6. Specify an authentication domain, identify the host, and accept the default port number of 1414.
7. Click **Next**, review your entries, and click **Finish**.

Be sure to register metadata for all of the queues and queue managers that are used in SAS jobs.

To begin running messaging jobs, make sure that the queue managers are running on their respective hosts.

**Manage Queues and Queue Managers**

To modify the metadata definitions of queues and queue managers, use the New Server Wizard in SAS Management Console to delete the existing definitions and create new definitions.
Before you delete metadata, you might want to run impact analysis and reverse impact analysis to see the jobs that include the queues. To run impact analysis or reverse impact analysis, follow these steps:

1. In SAS Data Integration Technologies, click the **Inventory** tab and expand **Message Queues**.

2. Right-click a message queue and select **Analyze**.

3. In the Analysis window, examine the graphical displays of impact analysis and reverse impact analysis to see how the message queue is used in existing jobs.

You can delete the message queue if the analysis diagrams show no connections to existing jobs or other metadata objects. If the diagrams show connections, edit or remove the metadata objects before you delete the message queue.

To delete metadata for queues and queue managers, right-click the object in the Server Manager of SAS Management Console and select **Delete**. Use the third-party software to delete the physical queue objects.

---

**Configuring the SAS Workspace Server to Enable the Bulk Loading of Data**

To improve performance, SAS Data Integration Studio transformations such as the Table Loader can be configured to use the bulk-load capabilities of native DBMS software.

To enable bulk-loading, you need to set the `-allowxcmd` option in the invocation statement for the object spawner that instantiates SAS sessions on the SAS Workspace Server.

To set `-allowxcmd` in the Windows operating environment, follow these steps:

1. On the SAS Workspace Server host, in a Command Prompt window, change directories to `SAS-configuration-directory\Lev1\ObjectSpawner`. 
2 Stop the object spawner by entering the command `ObjectSpawner stop`.

3 If the object spawner is set up to run as a service, remove the service. You can do this by entering the command `ObjectSpawner remove`.

4 Edit `ObjectSpawner.bat`, which is the script that is used to start the object spawner. Add the spawner invocation option `-allowxcmd` to the appropriate line. If you run the object spawner as a service (which is recommended), append the option to the line following the label `:install`. Otherwise, append the option to the line following the label `:start2`.

5 Save your changes.

6 If you want to run the object spawner as a service, install the service. You can do this by entering the command `ObjectSpawner install`.

7 Start the object spawner by entering the command `ObjectSpawner start`.

To set `-allowxcmd` in the UNIX operating environment, follow these steps:

1 Change directories to `../Lev1/appServer/ObjectSpawner`.

2 Stop the object spawner by entering the command `ObjectSpawner.sh stop`.

3 Edit the script `ObjectSpawner.sh` so that the command used to start the object spawner contains the option `-allowxcmd`. Add the option to the line that begins with `$CMD`, just before the first `>` sign.

4 Save your changes.

5 Restart the object spawner by entering the command `ObjectSpawner.sh start`. 
Setting X Command Options to Run Perl or Shell Scripts

If you intend to include UNIX scripts in your SAS Data Integration Studio jobs, you need to configure the SAS Workspace Server or batch server that runs the job. Specifically, in the server invocation statement, set the option `-allowxcmd` or `-nonoxcmd` to enable the server to execute operating system commands.

In your job or SAS program, set the option `-noxwait` to ensure that the program ends normally.

Another course of action is to select the Allow XCMD check box in the server's Advanced Options window. In the server properties window, select Options ➤ Advanced Options. Then click the Launch Properties tab.

Setting Up the SAS Data Quality Server Software

Overview of SAS Data Quality Server Software

SAS enterprise software offerings, such as SAS Data Management and SAS Data Integration Server, include SAS Data Integration Studio, SAS Data Quality Server, and the DataFlux Data Management Platform. The SAS Data Quality Server consists of a Quality Knowledge Base (QKB) and SAS language elements. The DataFlux Data Management Platform provides a single environment for managing data quality, data discovery, and master data management (MDM). Installing a Quality Knowledge Base enables the use of the data quality transformations in the Data Quality folder in SAS Data Integration Studio. You can also use the data quality functions in the Expression Builder. The Expression Builder is available in many data integration transformations.
SAS Data Integration Studio has additional transformations that execute data quality jobs and real-time services on DataFlux Data Management Servers. The DataFlux jobs and real-time services are created using DataFlux Data Management Studio. The DataFlux client enables you to analyze and profile data quality across your enterprise, and create customized Quality Knowledge Bases that enforce your business rules.

This section explains the installed configuration of the SAS Data Quality Server software, and how to perform a simple test to ensure that the system is working. This section also covers several administrative tasks associated with data quality, including the following:

- registering DataFlux Data Management Servers
- downloading new locales
- creating new schemes
- setting data quality options in SAS Data Integration Studio

**Note:** If you are unfamiliar with the subject of data quality technology and terminology, refer to any of the following documents: *SAS Data Quality Server: Reference*, *DataFlux Data Management Studio: User’s Guide*, and *DataFlux Data Management Server: Administrator’s Guide*.

### About the Data Quality Configuration

When you install the data quality software, the SAS Deployment Wizard installs and configures the SAS Data Quality Server, SAS Foundation, and SAS Data Integration Studio software. If you deploy an enterprise data integration software bundle, the SAS Deployment Wizard also installs the DataFlux client and server and creates metadata for the server. After installation, the data quality software is fully operational. The following information is provided so that you can change the default configuration.

The SAS Data Quality Server software is installed in `!SASROOT\dquality`. Locales and schemes are located in directories subordinate to `dquality: sasmisc \QltyKB\sample\locale` and `sasmisc\QltyKB\sample\scheme`. 
During execution, data quality jobs reference a specific Quality Knowledge Base (QKB) at a specific location. The location of the QKB can be specified by the job, by the Data Integration Studio client, or by one of two system defaults.

Data quality jobs can specify the location of a Quality Knowledge Base by specifying a value for the system option DQSETUPLOC.

To create jobs that reference non-default QKBs, open SAS Data Integration Studio, select **Tools** ➤ **Options**, and display the **Data Quality** tab.

To set a default QKB location on a SAS Application Server, open the file `SAS-configuration-directory\Lev1\SASApp\sasv9_usermods.cfg` and specify a new location, as shown in this example:

```
-dqsetuploc "C:\Program Files\DataFlux\QltyKB\CI\2010A"
```

When you install the server, the write-protected system default for DQSETUPLOC is specified in the file `SAS-configuration-directory\Lev1\SASApp\sasv9.cfg`. The default entry in that file is as follows:

```
DQSETUPLOC "!SASROOT\dquality\sasmisc\QltyKB\sample"
```

The default locale is set as follows in `sasv9_usermods.cfg`:

```
-dqlocale (ENUSA)
```

You can change values in the SAS configuration file `sasv9_usermods.cfg` without restarting servers. Any SAS Data Integration Studio clients need to be restarted in order to use new values.

**Note:** Do not edit `sasv9.cfg`, so that your system can revert to a known default state.

---

**Test the SAS Data Quality Server Software**

To verify that your SAS Data Quality Server software is working, create a job in SAS Data Integration Studio that contains a Create Match Code transformation.

Follow these steps to create such a job:

1. From the SAS Data Integration Studio desktop, select **Tools** ➤ **Process Designer** to start the New Job Wizard.
2 In the New Job Wizard, enter a name for the job (such as Create Database Match Codes) in the Name box. Then, click Finish. A new Process Designer window appears on the right side of your workspace.

3 From the Process Library tree, select and drag the Create Match Code template into the Process Designer.

4 From the Inventory tree, or another tree view, select and drag the metadata object for any table to the source drop zone.

5 From the Inventory tree, or another tree view, select and drag the metadata object for any table to the target drop zone. Both a Loader and the target table are added to the graphical representation of the job.

6 Double-click the Create Match Code transformation to display the Properties menu.

7 As the Properties window appears, a dialog box indicates that match definitions are being loaded from the Quality Knowledge Base. This indicates that the SAS Data Quality Server software has been properly installed and configured.

8 To see a list of the match definitions that were loaded, specify a source table for the job and display the Match Code tab of the Properties window. Double-click the Match Definitions column to show the list of match definitions.

Register a New DataFlux Data Management Server

DataFlux Management Servers run jobs and real-time services that are created with DataFlux Data Management Studio. One Data Management Server is installed and registered automatically when you install an enterprise data integration software bundle.

To register another DataFlux Integration Server in SAS metadata, follow these steps:

1 Open SAS Management Console, right-click the Server Manager, and select New Server.
2 In the New Server Wizard, select **Http server** and click **Next**.

3 Enter a name and optional description and click **Next**.

4 Enter the optional server software version number and vendor name.

5 Select or enter the network path to the DataFlux Integration Server.

6 For the **Application Server Type**, select **DataFlux Data Management Server**, and then click **Next**.

7 Select authentication and protocol options.

8 Specify the name of the host.

9 Accept the default port number 2136.

10 Specify a proxy URL if one is needed.

11 Click **Next**, review your entries, and click **Finish**. The new server appears in the **Plug-Ins** tab.

### Download Locales

When initially installed, the Quality Knowledge Base contains a single locale (English/USA). You can obtain additional locales from DataFlux at the following web address: [http://support.sas.com/qkbdownload](http://support.sas.com/qkbdownload). DataFlux regularly updates locales, so it is important that you install the latest versions after you install the data quality software.

If you install additional locales, you need to update your data quality setup file accordingly, as indicated in the documentation that is provided with each locale. Information about locating and editing the setup file is provided in the *SAS Data Quality Server: Reference*.

Note that you can create new locales and edit existing locales using DataFlux Data Management Studio.
Create Schemes

A scheme is a reusable collection of match codes and standardization values that is applied to input character values for the purposes of transformation or analysis. Schemes can be created in Blue Fusion Data (BFD) format or SAS format (NOBFD). Before your data integration developers can use the Apply Lookup Standardization template in SAS Data Integration Studio, you must specify a scheme repository and a scheme repository type. You also need to create schemes by using the SAS Data Quality Server or dfPower Studio software. For information about how to create schemes, see the relevant product documentation.

Scheme repositories should be separated based on scheme type. BFD schemes and NOBFD schemes should be stored separately to ensure that standardization jobs use the appropriate schemes. Two scheme repositories are provided in the default installation. On the SAS Application Server, the default scheme directory is `SAS-configuration-directory\Lev1\appServer\SASEnvironment\QltyKB\scheme`. This directory contains a number of BFD schemes that are supplied with the SAS Data Quality Server software.

A second default scheme directory is provided for interactive SAS sessions that are started on the local host: `..\dquality\sasmisc\content\scheme`.

In SAS Data Integration Studio, the scheme repository and the scheme repository type are specified in the Data Quality tab of the Options dialog box (select Tools ▶ Options). The default scheme repository type is dfPower Scheme (BFD). No default scheme repository is specified. When you specify a scheme repository in SAS Data Integration Studio, a full or explicit path is recommended. Relative paths must be specified relative to the SAS Application Server.

If you change an existing value in the Scheme Repository Type or Scheme Repository box, then you need to replace any existing instances of the Apply Lookup Standardization transformation. Replacement of the Scheme Repository Type or Repository is required. The scheme metadata is added to these jobs when they are run for the first time.

To update a job to use a different scheme repository:
1 Add a new Apply Lookup Standardization transformation to the job.

2 Configure the new transformation.

3 Delete the old transformation.

4 Move the new transformation into place.

Set Data Quality Options for SAS Data Integration Studio

You can set several options related to data quality by using the Data Quality tab in the Options dialog box in SAS Data Integration Studio (select Tools ▶ Options).

Redirecting Output and Logging Information to a File

SAS Data Integration Studio jobs generate SAS code when they are executed. It is sometimes useful to designate destinations for the outputs and logs that are associated with this code. To specify alternative destinations for the SAS log and SAS output, add the following options to the sas command that starts the SAS Workspace Server.

1 In SAS Management Console, expand the Server Manager, and then expand the node of the logical workspace server that is used by SAS Data Integration Studio clients.

2 Right-click the icon for the physical SAS Workspace Server, and select Properties from the pop-up menu.

3 In the Properties window, click the Options tab.

4 Edit the text in the Command text box. By default, this text is set as follows:

```
sas -config "SAS-configuration-directory\Lev1\appserver\sasv9_usermods.cfg"
```

To route the SAS log to a file, edit the command to make it look something like this:
For routing the SAS output to a file, the command should look like this:

```bash
sas -config "SAS-configuration-directory\Lev1\SASApp\sasv9_usermods.cfg"
   -print print-file-name.lst
```

5. If you are redirecting the log, enter the following parameter in the **Object Server Parameters** text box:

```
applevel=2
```

   This allows an appropriate level of log information to be routed to the file.

6. Click **OK** in the Workspace Server Properties dialog box.

---

### Enabling Status Code Handling

#### Overview of Status Code Handling

When a data integration developer executes a job in SAS Data Integration Studio, notification of the job's success or failure can be handled in many ways:

- It can be emailed to a person.
- It can be written to a file.
- It can cause the execution of an autocall macro.

A **Status Handling** tab is included in the property windows for jobs and for some transformations. Users can select options from a list of code conditions and actions on this tab. For example, a user can select a code condition such as **successful** and associate it with an action such as Send email.

Before data integration developers can use some of the actions, you must set up the environment properly. Such setup is required for the following actions:
Email actions: You must set SAS system options for mail for the SAS Application Server that is used to execute jobs.

Custom actions: You must make a SAS macro autocall library accessible by the SAS Application Server that is used to execute jobs.

Send Entry to a Data Set: You must pre-assign the library that contains the data set to a SAS Application Server before the job or transformation executes.

For information about how to support the first two actions listed above, see the following subsections. For information about libraries, see “Assigning Libraries” in SAS Intelligence Platform: Data Administration Guide.

Support the Email Action

Setting up the email action is simple. Just add the appropriate SAS system options for email to the configuration file ..\Lev1\appServer\sasv9_usermods.cfg. For example, if you are using the SMTP mail interface, you would add to this file the following options:

- -emailsys smtp
  - -emailhost email-server

In this case, the value of email-server specifies the SMTP server that supports mail access for your site.

Note: The mail system options are documented in SAS Help and Documentation.

Support the Custom Action

Using the Custom action, a data integration developer can execute a macro in a macro autocall library in order to provide user-defined status handling for a job or transformation. On the administrative side, all you need to do is to make sure that the autocall library is known to the SAS Application Server. You do this by editing the file ..\Lev1\appServer\sasv9_usermods.cfg. By default, the file contains a line similar to this:

- -sasautos ("SASEnvironment/sasMacro" SASAUTOS)
Add the library to the list of libraries in parentheses. The path to the library can be a full path or a path relative to ..\Lev1\appServer.

---

### Using FTP or HTTP Servers to Access External Files

External files are often stored on FTP or HTTP servers. To create a new FTP or HTTP server, follow these steps:

1. In SAS Management Console, right-click the **Server Manager** and select **New Server**.

2. In the **New Server** window, under Content Servers, select **Ftp Server** or **Http Server**, and then click **Next**.

3. Specify a server name and click **Next**.

4. Specify a base path for the server. Add the software version and vendor to help identify the server.

5. View and select the appropriate application server type, or accept the default value (None).

6. Select the **Supports SOAP-Based Web Services** check box if the new server supports those services, and then click **Next**.

7. Enter authentication and host information. For more information about authentication, see the *SAS Intelligence Platform: Security Administration Guide*.

8. Accept the default port number.

9. Enter a proxy URL to hide the direct path to the server.

10. Click **Next**, review your entries, and click **Finish**.
For more information about how to define a server, see the SAS Intelligence Platform: Application Server Administration Guide.
6

Administering SAS Enterprise Guide

Overview of SAS Enterprise Guide Administration ........................................... 95
  Introducing SAS Enterprise Guide .......................................................... 95
  Administrative Tasks .............................................................................. 95
  Unique Features of SAS Enterprise Guide Explorer ................................. 96
  SAS Enterprise Guide Features Available Only on the SAS Intelligence Platform ......................................................... 97

Migrate SAS Content with the Migration Wizard ........................................... 97
  Overview .............................................................................................. 97
  Prepare to Use the Migration Wizard ..................................................... 98
  Use the Migration Wizard ...................................................................... 99
  About the Migration Record File ............................................................ 100
  About the Mapping File .......................................................................... 101
  About the List of Files to Be Migrated .................................................... 104

Managing Connection Profiles in SAS Enterprise Guide ............................ 104
  About Connection Profiles ...................................................................... 104
  Add, Modify, or Delete Connection Profiles in SAS Enterprise Guide Explorer ...................................................................................... 106
  Specify the Active Profile ...................................................................... 107
  Select a Default SAS Workspace Server in Explorer ............................ 107
  Create an Automatic Default Connection Profile Deployment ............... 108
  Create a Shared Profile Deployment with Automatic Updates .............. 108
  Create an Initial Custom Profile Deployment ........................................ 110
  Deploy Customized Options .................................................................. 112
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Desktop Shortcuts for Profiles</td>
<td>113</td>
</tr>
<tr>
<td>Start SAS Enterprise Guide in No-Profile Mode</td>
<td>114</td>
</tr>
<tr>
<td><strong>Review Library Access in SAS Enterprise Guide</strong></td>
<td>114</td>
</tr>
<tr>
<td><strong>Managing Libraries with SAS Enterprise Guide Explorer</strong></td>
<td>117</td>
</tr>
<tr>
<td>Overview</td>
<td>117</td>
</tr>
<tr>
<td>About Libraries and Tables</td>
<td>117</td>
</tr>
<tr>
<td>About the Metadata LIBNAME Engine</td>
<td>118</td>
</tr>
<tr>
<td>Add a Library</td>
<td>119</td>
</tr>
<tr>
<td>Create an Output Library</td>
<td>119</td>
</tr>
<tr>
<td>Assigning Libraries</td>
<td>120</td>
</tr>
<tr>
<td>Reset a Library Login</td>
<td>120</td>
</tr>
<tr>
<td>Manage Logins with SAS Enterprise Guide Explorer</td>
<td>121</td>
</tr>
<tr>
<td><strong>Configure SAS Enterprise Guide for Integrated Windows Authentication</strong></td>
<td>121</td>
</tr>
<tr>
<td><strong>Configure SAS Enterprise Guide for Grid Computing</strong></td>
<td>122</td>
</tr>
<tr>
<td><strong>Configure SAS Enterprise Guide for Parallel Execution</strong></td>
<td>123</td>
</tr>
<tr>
<td><strong>Configure SAS Enterprise Guide to Access a Locked-Down SAS Server</strong></td>
<td>124</td>
</tr>
<tr>
<td><strong>Configure SAS Enterprise Guide to Turn Off the Automatic Check for Updates Feature</strong></td>
<td>124</td>
</tr>
<tr>
<td><strong>Configure SAS Enterprise Guide to Hide the Check for Updates Option</strong></td>
<td>125</td>
</tr>
<tr>
<td><strong>Tasks That Require Other SAS Software</strong></td>
<td>126</td>
</tr>
<tr>
<td><strong>Default Roles and Capabilities for SAS Enterprise Guide</strong></td>
<td>126</td>
</tr>
<tr>
<td><strong>Registering Custom Tasks as Capabilities in SAS Enterprise Guide</strong></td>
<td>143</td>
</tr>
<tr>
<td>Overview</td>
<td>143</td>
</tr>
<tr>
<td>Create Custom Tasks</td>
<td>143</td>
</tr>
<tr>
<td>Deploy Custom Tasks</td>
<td>144</td>
</tr>
<tr>
<td>Register Custom Tasks as Capabilities in SAS Enterprise Guide</td>
<td>145</td>
</tr>
</tbody>
</table>
Overview of SAS Enterprise Guide Administration

Introducing SAS Enterprise Guide

SAS Enterprise Guide provides a graphical interface and a task structure for the SAS programming language. Wizards and menu options enable you to quickly generate projects, tasks, and process flows. The process flows analyze data, create graphs, and generate reports. Behind each process flow is a SAS program that you can execute and edit.

With SAS Enterprise Guide, you can access data in many formats and third-party databases, in operating environments including UNIX, z/OS, and Windows.

If you build and maintain OLAP cubes using SAS OLAP Server, you can query those cubes using SAS Enterprise Guide.

When users connect to a SAS Metadata Server within the SAS Intelligence Platform, the primary administrative application is SAS Management Console. Several additional administrative features are provided by the SAS Enterprise Guide Explorer application. If you run SAS Enterprise Guide without a SAS Metadata Server, then SAS Enterprise Guide Explorer is your administrative application.

Administrative Tasks

To administer SAS Enterprise Guide, you perform the following tasks:

- create, manage, and deploy connection profiles
- configure access controls
- monitor log files as needed

Note: Use SAS Management Console or SAS Data Integration Studio to create and modify library definitions in metadata.
The following diagram depicts how you use administrative tools to create and access libraries.

**Figure 6.1 Using SAS Management Console and SAS Enterprise Guide Explorer within the SAS Intelligence Platform**

**Unique Features of SAS Enterprise Guide Explorer**

SAS Enterprise Guide Explorer adds the following administrative features to those that are provided by SAS Management Console:

- administering a common environment configuration for SAS Enterprise Guide users
- importing tasks created on other instances of SAS Enterprise Guide
- deploying connection profiles between instances of SAS Enterprise Guide
SAS Enterprise Guide Features Available Only on the SAS Intelligence Platform

Using SAS Enterprise Guide within the SAS Intelligence Platform provides access to the following features:

- stored processes
- information maps
- roles and capabilities
- SAS folders
- publishing

Migrate SAS Content with the Migration Wizard

Overview

You migrate your SAS content for any combination of the following reasons:

- upgrade to a new version of SAS Enterprise Guide or the SAS Add-In for Microsoft Office
- move your projects to a new repository
- move your SAS Metadata Server
- update metadata references in your projects
- update file references in your projects

You migrate your SAS content with the Migration Wizard. The wizard updates the file format and metadata references in SAS Enterprise Guide projects. The wizard also updates metadata references in Microsoft Office files that include SAS content. SAS content is added to Microsoft Office files using the SAS Add-In for Microsoft Office. The
metadata references identify metadata objects that are defined on your SAS Metadata Server. The metadata objects in turn identify servers, libraries, cubes, stored processes, and information maps.

The Migration Wizard processes the following types of files:

- SAS Enterprise Guide projects (*.egp)
- SAS Web Report Studio reports
- SAS Information Map Studio information maps
- OLAP cubes created in SAS Enterprise Guide and SAS OLAP Cube Studio
- Microsoft Excel files
- Microsoft Word documents
- Microsoft PowerPoint presentations

You can run the Migration Wizard interactively. The interactive wizard helps you locate files for migration, identifies the metadata references in the files that you select, and enables you to change the metadata references.

The Migration Wizard generates a migration record file, which identifies all of the migrated files and all of the updates to metadata references in your projects. The wizard also generates a log file. In interactive mode, the wizard gives you the option to generate a migration record file and enables you to change the default storage location of the log file.

You can supply a migration record file to the wizard as input, along with an optional mapping file and an optional list of files to be migrated. You can edit the XML tags in all three input files.

**Note:** The Migration Wizard does not carry forward any of the roles or capabilities that you might have defined in the previous release. When you move to a new release, you need to re-enter your roles and capabilities.

**Prepare to Use the Migration Wizard**

Follow these steps before you run the Migration Wizard:
1 As needed, install the new versions of SAS Enterprise Guide and the SAS Add-In for Microsoft Office.

2 To migrate SAS content in Microsoft Office files, ensure that the SAS Add-In for Microsoft Office is installed on the host that runs the Migration Wizard.

3 Add any new metadata references to your existing SAS content. (The Migration Wizard does not add new metadata references.)

4 Move or copy your existing SAS content into its new repositories. Keep track of the projects, directories, and files for later use in the Migration Wizard, or you can build your own migration record file and list of files to be migrated for input to the wizard.

5 Update all metadata references on your SAS Metadata Server. Record the metadata changes for later use in the Migration Wizard, or you can create a mapping file as you go.

6 Store any of the three migration files in the following directory: `\MyDocuments \Application Data\SAS\BI Clients\version-number\Migration`.

**Use the Migration Wizard**

Follow these steps to use the Migration Wizard:

1 Close all Microsoft Windows applications (other than Microsoft Explorer).

2 If you are supplying a migration record file as input, execute the Migration Wizard from a command line as follows:

   ```
   MigrationWizard migration-record-filename
   ```

3 If you are not using a migration record file, note that the Migration Wizard does not process any files until you click **Finish**. Double-click `MigrationWizard.exe`.

4 On the first page of the wizard, read an introduction to the wizard.
5 On the second page of the wizard, verify or modify the active connection.

6 On the third page of the wizard, move files, folders, or servers into the **Selected Files** area to specify files for migration. Click **Add Location** to select files stored on other hosts.

7 Page 4 of the wizard explains the process of identifying metadata references that might need to be changed.

8 On page 5 of the wizard, if a mapping file exists in the specified location, you are asked if you want to use it. Page 5 then lists all of the metadata references in the files that you selected for migration. You can update any of these references. Updates are applied at the completion of the wizard.

9 On page 6 of the wizard, you specify the name of the optional migration record file. You can also specify that the wizard is to verify the existence of the updated metadata references and note the findings in the migration wizard log. The updates are made regardless of the verification. To enable verification, you need Read access to the metadata objects and to the migrated files.

### About the Migration Record File

The Migration Wizard creates a new XML migration record file at the end of its process. The migration record file contains a reference to the applicable SAS Metadata Server, a list of files migrated, and a list of mappings. In this case, the term *mappings* refers to updates to metadata references.

When you run the Migration Wizard interactively, the wizard prompts you for a storage location for the migration record file. If you do not specify a location, the file is not generated.

When you run the Migration Wizard, you specify a migration record file as an input to the Migration Wizard. When you do so, the wizard applies the specified set of mappings to the specified list of files.

You can use the following XML syntax to construct your own migration record file or to edit an existing migration record file. You also have the option of using a separate file to...
specify the list of files to be migrated. You can use a third file to specify your mappings (updates to metadata references). XML tags in the migration record file specify the locations of the mapping file and the list of files to be migrated.

The migration record file contains the following XML syntax (minus the comments):

```xml
<MigrationRecordFile filename="migration-record-file-name">
  <MetaDataServer profile="server-name" hostname="full-host-name"
  port="server-port-number">
    ...
  </MetaDataServer>

  <FileList>
    <File>
      <FullNodePath>full-path-to-file</FullNodePath>
    </File>
    <File>
      <FileType>Local</FileType>
      <FullPath>path-to-local-file</FullPath>
      <FullNodePath>network-path-to-local-file</FullNodePath>
    </File>
  </FileList>
  
  <!-- To use a list of files to be migrated, replace FileList with LoadFileList. -->
  <LoadFileList filename="name-of-file"/>

  <MappingInformation>
    <MappedItem>
      <!-- See the topic About the Mapping File for these tags. -->
    </MappedItem>
  </MappingInformation>
  
  <!-- To use a mapping file, replace MappingInformation with LoadMappingInformation. -->
  <Load MappingInformation filename="name-of-file"/>
</MigrationRecordFile>
```

**About the Mapping File**

You can create a mapping file in XML to provide the Migration Wizard with a reusable and standardized set of updates for the metadata references in your SAS content. In the mapping file, you identify existing metadata references and specify new metadata definitions for those references. The result is that your SAS content contains metadata references that reflect the metadata definitions on your SAS Metadata Server.
When you run the Migration Wizard interactively, you are asked if you want to use a mapping file. If you opt to use a mapping file, the wizard searches all of the files to be migrated for the metadata references in the mapping file. When the wizard finds a metadata reference, it adds the intended change to the list of changes. You can at that point approve or delete any of the intended updates to metadata references.

The mapping file must be stored in the same directory as the list of files to be migrated on the host that runs the Migration Wizard. The location is the application data directory of the user who runs the Migration Wizard: `%APPDATA%\SAS\SharedSettings\version-number\Migration\filename.xml`. In the Windows 7 operating environment, this path resolves to `C:\Users\user-id\AppData\Roaming\SAS\SharedSettings\version-number\Migration\filename.xml`.

When you run the wizard, you edit your migration record file to specify the name of mapping file.

To create your mapping file, apply any number of the following MappedItem tags (named metadata objects) for your particular set of ReferenceTypes (object types):

```xml
<MappingInformation>
  <MappedItem>
    <ReferenceName>server-name</ReferenceName>
    <ReferenceID>server-id</ReferenceID>
    <ReferenceType>Server</ReferenceType>
    <CurrentMapping>old-server-definition</CurrentMapping>
    <NewMapping>new-server-definition</NewMapping>
  </MappedItem>
  <MappedItem>
    <ReferenceName>library-name</ReferenceName>
    <ReferenceID>library-id</ReferenceID>
    <ReferenceType>LIBRARY</ReferenceType>
    <CurrentMapping>old-library-definition</CurrentMapping>
    <NewMapping>new-library-definition</NewMapping>
  </MappedItem>
  <MappedItem>
    <ReferenceName>stored-process-name</ReferenceName>
    <ReferenceID>stored-process-id</ReferenceID>
    <ReferenceType>SAS.EG.ProjectElements.StoredProcess</ReferenceType>
    <CurrentMapping>old-stored-process-definition</CurrentMapping>
    <NewMapping>new-stored-process-definition</NewMapping>
  </MappedItem>
  <MappedItem>
    <ReferenceName>external-file-name</ReferenceName>
    <ReferenceID>external-file-id</ReferenceID>
  </MappedItem>
</MappingInformation>
```
<MappedItem>
  <ReferenceName>information-map-name</ReferenceName>
  <ReferenceID>information-map-id</ReferenceID>
  <ReferenceType>SAS.EG.ProjectElements.InformationMap</ReferenceType>
  <CurrentMapping>old-information-map-location</CurrentMapping>
  <NewMapping>new-information-map-location</NewMapping>
</MappedItem>

<MappedItem>
  <ReferenceName>cube-name</ReferenceName>
  <ReferenceID>cube-id</ReferenceID>
  <ReferenceType>SAS.EG.ProjectElements.Cube</ReferenceType>
  <CurrentMapping>old-cube-location</CurrentMapping>
  <NewMapping>new-cube-location</NewMapping>
</MappedItem>

<MappedItem>
  <ReferenceName>OLAP-catalog-name</ReferenceName>
  <ReferenceID>OLAP-catalog-ID</ReferenceID>
  <ReferenceType>OLAPCATALOG</ReferenceType>
  <CurrentMapping>old-catalog-definition</CurrentMapping>
  <NewMapping>new-catalog-definition</NewMapping>
  <OLAPCatalogName>old-OLAP-catalog-name</OLAPCatalogName>
  <OLAPServerName>old-OLAP-server-name</OLAPServerName>
  <OlapServerType>old-OLAP-server-type</OlapServerType>
  <OlapProviderName>old-OLAP-provider</OlapProviderName>
  <OlapLoginMode>old-login-mode</OlapLoginMode>
  <OlapExtProperties>old-extended-srvr-conn-props</OlapExtProperties>
  <OlapHostName>old-host-name</OlapHostName>
  <OlapPort>old-port</OlapPort>
  <NewOLAPCatalogName>new-OLAP-catalog-name</NewOLAPCatalogName>
  <NewOLAPServerName>new-OLAP-server-name</NewOLAPServerName>
  <NewOlapServerType>new-OLAP-server-type</NewOlapServerType>
  <NewOlapProviderName>new-OLAP-provider</NewOlapProviderName>
  <NewOlapLoginMode>new-login-mode</NewOlapLoginMode>
  <NewOlapExtProperties>new-extended-srvr-conn-props</NewOlapExtProperties>
  <NewOlapHostName>new-host-name</NewOlapHostName>
  <NewOlapPort>new-port</NewOlapPort>
</MappedItem>

<MappedItem>
  <ReferenceName>OLAP-server-name</ReferenceName>
  <ReferenceID>OLAP-server-id</ReferenceID>
  <ReferenceType>OLAPSERVER</ReferenceType>
  <CurrentMapping>old-server-definition</CurrentMapping>
</MappedItem>
About the List of Files to Be Migrated

The Migration Wizard can use a list of files to be migrated when you execute the wizard from a command line. To create a list of files to be migrated, use the XML syntax for the FileList tag, as shown in “About the Migration Record File”. In the migration record file, you replace the FileList tag with the LoadFileList tag. The LoadFileList tag specifies the name of the list of files to be migrated.

The list of files to be migrated must be stored in the same directory as the mapping file.

Managing Connection Profiles in SAS Enterprise Guide

About Connection Profiles

After you install SAS Enterprise Guide, you either create one or more connection profiles for the user or you configure the application to run in no-profile mode, as described in “Start SAS Enterprise Guide in No-Profile Mode” on page 114.
If you have a profile, you connect to a SAS Metadata Server by default when you start SAS Enterprise Guide. You can also select a profile to access a different SAS Metadata Server.

Within the SAS Intelligence Platform, the connection to the SAS Metadata Server requires agreement between the installed versions of the software, as defined in the following table.

**Table 6.1  Software Compatibility by Release**

<table>
<thead>
<tr>
<th>SAS Enterprise Guide Release</th>
<th>Compatible SAS Metadata Server Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1</td>
<td>9.1.3</td>
</tr>
<tr>
<td>4.2</td>
<td>9.2</td>
</tr>
<tr>
<td>4.3</td>
<td>9.2 and 9.3</td>
</tr>
<tr>
<td>5.1</td>
<td>9.2, 9.3, and 9.4</td>
</tr>
<tr>
<td></td>
<td>(SAS Enterprise Guide 5.1 works with SAS 9.4, but requires hotfix 15 (G35015) or later.)</td>
</tr>
<tr>
<td>6.1</td>
<td>9.2 ts2m3, 9.3, and 9.4</td>
</tr>
<tr>
<td>7.1</td>
<td>9.2 ts2m3, 9.3, and 9.4</td>
</tr>
</tbody>
</table>

You can deploy SAS Enterprise and SAS Add-In for Microsoft Office clients with an automatic default connection profile. See “Create an Automatic Default Connection Profile Deployment” on page 108.

You can deploy and maintain connection profiles from a central location, and you can update profiles automatically from that central location when you start SAS Enterprise Guide. See “Create a Shared Profile Deployment with Automatic Updates” on page 108.

You can deploy an initial custom profile, which requires creating a configuration profile without credentials and saving it in the SAS software depot. See “Create an Initial Custom Profile Deployment” on page 110.
Add, Modify, or Delete Connection Profiles in SAS Enterprise Guide Explorer

To administer connection profiles, follow these steps:


2. In the SAS Enterprise Guide Explorer, select File ▶ Manage Profiles.

3. In the Connections dialog box, select Profiles to add, modify, or delete connection profiles, or select Updates to specify and invoke a profile configuration file. Select Servers to specify the default SAS Workspace Server, as described in the next section.

4. Click Add to create a new profile.

5. In the Create Profile dialog box, specify a server name and optional description.

6. For remote servers, enter a network name in the Machine box.

7. Confirm that Port is set to the correct SAS Metadata Server port number if the deployment does not use the default.

8. To authenticate users with the user ID and password that are defined in the Windows operating environment, select the Use Integrated Windows Authentication check box.

9. If an authentication domain has been implemented, enter the name of that domain in the Authentication domain box. Otherwise, leave the box blank. For information about authentication domains, see SAS Intelligence Platform: Security Administration Guide.

10. Click Save to add the new profile.

11. To activate the new profile, select it in the Connections dialog box and select Set Active. If a previous connection was active, it is closed and a new connection is
opened. The selected profile is activated each time the user opens SAS Enterprise Guide. The active profile can be changed at any time.

Specify the Active Profile

You can specify one profile as the active profile. To specify an active profile, follow these steps:

1. Select File ➤ Manage Profiles to open the Connections dialog box.
2. Select Profiles from the selection pane.
3. Select a profile from the list of defined profiles, and then click Set Active.

Select a Default SAS Workspace Server in Explorer

SAS Workspace Servers execute SAS programs and stored processes as they are requested by SAS Enterprise Guide. To specify the server that runs SAS for a given instance of SAS Enterprise Guide, follow these steps:

2. In the SAS Enterprise Guide Explorer, select File ➤ Manage Profiles.
3. Click Servers, and then click the down arrow to select a default SAS server.
   
   Note: Performance improvements can be achieved when groups of users select a load-balancing cluster of SAS Workspace Servers. For information about load-balancing, see the SAS Intelligence Platform: Application Server Administration Guide.

4. If a SAS Workspace Server exists on the local host, and you want that server to appear in the list of servers, select Automatically add local SAS server (if installed) to the list. The server does not need to be registered on the SAS Metadata Server for this feature.
Create an Automatic Default Connection Profile Deployment

If you install from a planned deployment that contains a SAS Metadata Server, then a default connection profile that points to that SAS Metadata Server is created for SAS Enterprise Guide and SAS Add-In for Microsoft Office.

Create a Shared Profile Deployment with Automatic Updates

The SAS Enterprise Guide and SAS Add-In for Microsoft Office clients update their profile (manually or automatically) from a shared profile stored in a central location when using this method. After you define profiles, you can deploy those profiles across your enterprise. You can also automatically update your profiles when you initialize SAS Enterprise Guide. The automatic update specifies a set of profiles and an active profile.

SAS Add-In for Microsoft Office shares profile information with SAS Enterprise Guide. When you create a shared profile deployment, SAS Add-In for Microsoft Office and SAS Enterprise Guide update their profiles automatically. Profiles are updated when you start SAS Enterprise Guide or start a Microsoft Office application.

Follow these steps to create a shared profile deployment and enable the automatic update of profiles:


3. On page 1 of the wizard, read the wizard tasks and click Next.

4. On page 2, confirm that the desired active profile is selected. If you want a different profile to be active when the profiles are deployed, click Configure Profiles... to change the active profile. Click Next.

5. On page 3, you can test each connection profile that is defined by clicking Begin Test. This step is optional. Click Next.
6 On page 4, specify a network-accessible storage location that clients can access when looking for the new SDSUpdate.xml update file. Make sure that the storage location can be accessed by all relevant instances of SAS Enterprise Guide and the SAS Add-In for Microsoft Office.

7 On page 5, specify a local storage for SDSUpdate.xml and SDSControl.xml. This is a staging folder. You need to move the files to their appropriate respective locations to actually cause the updates to occur.

8 On page 6, click Finish to generate the configuration files.

9 When you click Finish, the Profile Deployment Wizard creates an SDSUpdate.xml file that contains the metadata connection data with all user names and passwords removed and an SDSControl.xml file that describes how the updates should be applied.

10 To deploy SAS Enterprise Guide with instructions to automatically update its profile from the shared profile, copy the SDSControl.xml file from your staging folder into your SAS software depot. Copy the file into the top-level directory for SAS Enterprise Guide. Here is a typical network location:

   \depot-host\Depot_date_type\products\eguide_release_win_en_en_sp0\1
   \depot-host\Depot_date_type\products\eguide_release_wx6_en_en_sp0\1

   This causes the clients that are installed from this depot to examine the location specified on page 4 of the Profile Deployment Wizard for a new update file.

   Note: For the first maintenance release for SAS Enterprise Guide 6.1, use one of the following examples:

   \depot-host\Depot_date_type\products\eguide_release_cd915_win_en_en_sp0\1
   \depot-host\Depot_date_type\products\eguide_release_cd915_wx6_en_en_sp0\1

11 Copy the generated SDSUpdate.xml file to the path specified on page 4 of the Profile Deployment Wizard so that the clients retrieve that file and apply it the next time they are started.

12 You need to do steps 12 through 15 manually only if the SDSControl.xml file was not deployed by the actions taken in step 10. If you do step 10 when you install SAS
Enterprise Guide from this depot, then steps 12 through 15 automatically happen on the client.

To enable the automatic update of profiles on other hosts, open SAS Enterprise Guide Explorer, open the File menu, and select Manage Profiles.

13 In the Connections window, select Updates.

14 Select Update profiles automatically.

15 In the field Location of update file, specify the network storage location of the file SDSUpdate.xml.

16 To update profiles immediately, click Check for updates now.

Create an Initial Custom Profile Deployment

Unlike the shared profile that is stored in a central location that both the SAS Enterprise Guide and the SAS Add-In for Microsoft Office clients can update from manually or automatically, the initial custom profile delivers the desired profile directly to each client during deployment (nothing is stored centrally).

Follow these steps to create an initial custom profile deployment using the Profile Deployment Wizard:

1 Open SAS Enterprise Guide, and then select Tools ➤ SAS Enterprise Guide Explorer.

2 In SAS Enterprise Guide Explorer, select Tools ➤ Profile Deployment Wizard.

3 On page 1 of the wizard, read the wizard tasks and click Next.

4 On page 2, click Configure Profiles to display the Connections dialog box. Click Add or Modify to specify the profiles that you plan to deploy. Select the profile that you want to be the active profile.

5 On page 3, click Begin Test to test your profiles. When you have finished the test, click Next.
6 On page 4, enter any path for the location of the update file and click **Next**. This path is not used when creating an initial custom profile deployment.

7 On page 5, specify a local storage location for the configuration files. The directory that you specify receives two files: SDSControl.xml and SDSUpdate.xml.

8 On page 6, click **Finish** to generate the configuration files. The SDSUpdate.xml file contains the profiles selected on page 2, but with user and password information removed.


10 Go to the directory specified on page 5, and rename SDSUpdate.xml to ConfigurationV71.xml. Delete the SDSControl.xml file.

11 Copy or move the new ConfigurationV71.xml from your local storage location to your SAS software depot. Locate the file in the two top-level en directories for SAS Enterprise Guide. Note that the files are added only to the English locale folders regardless of the languages being installed. Here are typical locations:

\depot-host\Depot_date_type\products\eguide__release__win__en__sp0__1
\depot-host\Depot_date_type\products\eguide__release__wx6__en__sp0__1

**Note:** For the first maintenance release for SAS Enterprise Guide 6.1, use the following example:

\depot-host\Depot_date_type\products\eguide__release_cd915__win__en__sp0__1
\depot-host\Depot_date_type\products\eguide__release_cd915__wx6__en__sp0__1

As an advanced alternative to steps 1 through 10, for step 11 you can use a copy of an existing ConfigurationV61.xml or ConfigurationV71.xml file, located in %APPDATA%\SAS \MetadataServerProfiles. The Profile Deployment Wizard removes all user names and passwords from the file when creating the SASUpdate.xml file. So if you use this approach, you must hand edit the file to remove all User and Password elements.

1 Edit a copy of an existing ConfigurationV71.xml file from %APPDATA%\SAS \MetadataServerProfiles. Remove all User and Password elements from the XML file.
Copy or move the edited ConfigurationV71.xml file from your local storage location to your SAS software depot. Locate the file in the two top-level en directories for SAS Enterprise Guide. Note that the files are added only to the English locale folders regardless of the languages being installed. Here are typical locations:

```
\depot-host\Depot_date_type\products\eguide__release___win__en__sp0__1
\depot-host\Depot_date_type\products\eguide__release___wx6__en__sp0__1
```

**Note:** For the first maintenance release for SAS Enterprise Guide 6.1, use the following example:

```
\depot-host\Depot_date_type\products\eguide__release_cd915___win__en__sp0__1
\depot-host\Depot_date_type\products\eguide__release_cd915___wx6__en__sp0__1
```

With the configuration file in place, you can now deploy SAS Enterprise Guide to new hosts from your depot with pre-configured profiles and a specified active profile.

**Deploy Customized Options**

Follow these steps to deploy a standardized set of site-specific SAS Enterprise Guide options:

1. Start the instance of SAS Enterprise Guide in your SAS software depot, and then select **Tools ➤ SAS Enterprise Guide Explorer**.


3. In the Options dialog box, review and update each option in each category to meet the needs of your enterprise.

4. Click **Save As** to open the Save File window. Note the default storage location, and then click **Save** to update the file EGOptions.xml.

5. To deploy SAS Enterprise Guide with customized options, copy the file EGOptions.xml from your host into your SAS software depot. Copy the file into the top-level directory for SAS Enterprise Guide. Here is a typical network location:

```
\depot-host\Depot_date_type\products\eguide__release___win__en__sp0__1
```
Create Desktop Shortcuts for Profiles

After you create profiles, you can associate profiles with shortcuts on the Windows desktop. This capability enables you to start SAS Enterprise Guide with a specific profile by clicking on a specific shortcut. You can also start SAS Enterprise Guide without a profile by using a desktop shortcut.

To associate a profile with a desktop shortcut, follow these steps:

1. Create a shortcut for the file SEGuide.exe. By default, it is in one of the following directories:
   - for x64: C:\Program Files\SASHome\SASEnterpriseGuide\version.
   - for x32: C:\Program Files\SASHome\x86\SASEnterpriseGuide\version

2. Right-click on the shortcut that you created and select Properties.

3. To start SAS Enterprise Guide by using a specific profile, locate the path in the Target box. At the end of the path, add a blank space and type /profile: profile-name. If the profile name includes spaces, you must enclose the name in quotation marks:
   "C:\Program Files\SASHome\SASEnterpriseGuide\x.x\SEGuide.exe" /profile:“Cube Query 1”

4. To use the shortcut to run SAS Enterprise Guide without a profile, add /noprofile to the end of the Target box:
   "C:\Program Files\SASHome\SASEnterpriseGuide\x.x\SEGuide.exe" /noprofile
5 Click OK.

Start SAS Enterprise Guide in No-Profile Mode

To run SAS Enterprise Guide without a profile, display the Connections dialog box, select Profiles, and then select <do not use a profile>.

Review Library Access in SAS Enterprise Guide

When you create a library using SAS Management Console, the library is defined on the SAS Metadata Server, and the library assignment is shared across SAS servers. In SAS Enterprise Guide, access to registered libraries is determined in part by the method that is used to assign those libraries.

For information about library management, see SAS Intelligence Platform: Data Administration Guide.

To ensure appropriate library access for each SAS Enterprise Guide client, follow these steps:

1 Review the library assignment method based on the access requirements of the SAS Enterprise Guide client and the access controls on the registered libraries.

   Note: The library assignment method can be modified within SAS Management Console by modifying the value of the AssignMode extended attribute as described in the following items.

   The library assignment methods are defined as follows:

SAS Enterprise Guide
   assigns the library based on the engine and LIBNAME statement options that are defined on the SAS Metadata Server. When you choose this library assignment
method, SAS Enterprise Guide ignores table and column metadata access control (Read, Write, Create, Delete).

**Note:** This assignment method is indicated in SAS Management Console by setting the value of the AssignMode extended attribute to 0.

Use this library access method when the client requires Write access to the library, and when the tables in the library are not subject to access control. If Write access to a registered library is not required, use **Metadata Library Engine**.

Write access to registered libraries should be closely monitored because the SAS code that is generated by SAS Enterprise Guide does not automatically synchronize metadata. Changes to columns are written into the physical table, but are not written into the table metadata.

Note that you can edit the code that is generated by SAS Enterprise Guide to include the METALIB procedure, which can be used to update table metadata. You can also use the Update Library Metadata task available on the SAS Enterprise Guide Tools menu to refresh the library metadata.

**SAS Server**

assumes that the library is pre-assigned on the SAS server using an AUTOEXEC or the METAAUTOINIT process that runs when the server is initialized. Metadata access control for tables and columns is enforced only if the pre-assignment uses the Metadata Library Engine.

Use this library access method to assign a library consistently across clients. The clients include SAS Enterprise Guide, the SAS Add-In for Microsoft Office, and the SAS Stored Process Server. Note that this assignment method is indicated in SAS Management Console by setting the value of the AssignMode extended attribute to 3.

**Metadata Library Engine**

assigns the library using the metadata LIBNAME engine. By default, the library is Read-Only. You cannot add or create new tables, and SAS Enterprise Guide displays registered tables only. Use this library assignment method to protect the referential integrity of the table metadata. This method is recommended for OLAP cube libraries.
To enable Write access at the library level and enforce metadata access control at the table and column level, deselect the check box labeled **Show only tables with metadata definitions**. With this library access method, SAS Enterprise Guide displays all of the tables in the library, including any tables that are not registered. For more information, see “About the Metadata LIBNAME Engine” on page 118.

**Note:** This assignment method is indicated in SAS Management Console by setting the value of the AssignMode extended attribute to 1, 2, or 4. When the value is 1 or when AssignMode is not specified, only registered tables are shown. When the value is 2, both registered and unregistered tables are shown. When the value is 4, only registered tables are shown. New tables can be created, as described in “About the Metadata LIBNAME Engine” on page 118.

2 If the assignment method for the selected library does not meet the needs of the SAS Enterprise Guide client, use SAS Management Console. SAS Management Console is used to change the library assignment, create new libraries, or change access permissions.

3 At a minimum, make sure that you review the assignment methods for all of the registered libraries that require Write access from SAS Enterprise Guide clients.

4 Creating and modifying library metadata affects all users of the altered library in all applications. Therefore, administrators might consider disabling the ability of users to modify library metadata. This can be done by restricting Write access to specific library objects by using SAS Management Console, or by denying users the Update Library Metadata and Create Library Metadata role capabilities.

Note that the library assignment methods that you select in SAS Enterprise Guide also apply to the SAS Add-In for Microsoft Office. For more information about the SAS Add-In for Microsoft Office, see *Administering the SAS Add-In for Microsoft Office on page 15*.

For information about metadata access control, see see “Metadata Authorization Model” in *SAS Intelligence Platform: Security Administration Guide*.

For information about pre-assigned libraries, see “Assigning Libraries” in *SAS Intelligence Platform: Data Administration Guide*. 
Managing Libraries with SAS Enterprise Guide Explorer

Overview

SAS Enterprise Guide Explorer displays metadata objects in a tree. You can expand an element in the tree to view the contained objects. You might be asked to enter a user ID and password to view those objects.

When your user definition connects you to a SAS Metadata Server, you use SAS Management Console to create server definitions and library definitions. When the server definitions and library definitions are available, you can use SAS Management Console or SAS Enterprise Guide Explorer to manage libraries, tables, and logins.

For information about creating and managing servers, see the SAS Intelligence Platform: Application Server Administration Guide. For additional information about configuring libraries on network servers, see the SAS Intelligence Platform: Data Administration Guide.

About Libraries and Tables

Libraries are collections of files that are stored on servers and accessed from SAS Enterprise Guide. When you add a metadata definition for a library, you make the metadata definition available to all the network SAS Enterprise Guide installations that have access to a specific metadata repository. Access is also granted to all other applications that use the repository. The metadata definition for a library includes the path, engine, and other options for the library. The metadata definition corresponds to the information that is specified in a LIBNAME statement.

The options that are specified in a library definition work like the commands in an AUTOEXEC.BAT file. These LIBNAME statement options are stored on the client and then executed when a SAS Enterprise Guide application connects to the specified SAS server.
Table definitions specify the tables and columns that are available within a library. You can create table definitions by using one of the following functions:

- using the Update Library Metadata function in SAS Enterprise Guide
- using the Register Tables function in SAS Management Console
- running the METALIB procedure in a SAS session (which synchronizes metadata with the physical contents of a library)
- using SAS Data Integration Studio to build a data warehouse

You can include authorization settings for both library and table definitions. The authorizations specify which libraries and tables a user can access and whether the user can change the contents of a library.

**About the Metadata LIBNAME Engine**

To understand how SAS Enterprise Guide assigns and accesses libraries, it is helpful to understand the metadata LIBNAME engine. The META engine enables you to use a LIBNAME statement to reference a metadata definition for a library, rather than specifying a physical location. By default, the META engine provides Read-Only access to a library, which prevents the library contents from being different from the library metadata.

If you use the METAOUT=DATA option in the LIBNAME statement, the META engine can access tables that are not defined in metadata but that exist in the physical library. This option enables you to add and modify tables in the library. However, any metadata authorization settings that have been applied to tables or columns in the library are enforced. If a SAS program changes the contents of a library that uses the METAOUT=DATA option, you must synchronize the physical data and the metadata. To synchronize the data, you can use the Register Tables function in SAS Management Console, the METALIB procedure, or the Update Library Metadata task in SAS Enterprise Guide.

Beginning in the third maintenance release for SAS 9.4, if a DBMS library is set to PROMPT and the server version is the third maintenance release for 9.4 or later, then SAS Enterprise Guide prompts for user credentials and passes them to the META engine using the new DBUSER= and DBPASS= LIBNAME options. These options
enable customers to supply credentials for libraries whose server definitions have an authentication type of Prompt defined. They can also be used to override the predefined metadata authentication type. The credentials must be valid on the target DBMS.

**Add a Library**

*Note:* The ability to add library definitions to metadata was removed from SAS Enterprise Guide Explorer Version 7.1. Users can still create ad hoc libraries using the Project Library Wizard in SAS Enterprise Guide, the library definition is not stored in metadata. Administrators should create metadata library definitions using the New Library Wizard in SAS Management Console.

**Create an Output Library**

By default, SAS Enterprise Guide stores output data in the Sasuser, Work, or Egtask library, or a user-created output library on a SAS server. To change the default output library, select **Tools ▶️ Options ▶️ Output Library**. You might want to change the default output directory to create a library that can be accessed by all SAS Enterprise Guide users.

Be sure not to direct output to Work on a UNIX or z/OS server, because that library is temporary in those operating environments.

To change your output directory, open SAS Management Console and select **Data Library Manager**, and then select **New Library**. Choose **Pre-assigned Library** as the library type to ensure that the library is assigned whenever the server starts. Make sure that the library is defined on all servers that is used with SAS Enterprise Guide.

Another strategy for changing your output library is to use SAS Management Console to add the LIBNAME statement for the library to all server definitions that are used by SAS Enterprise Guide. For new servers, include the statement in the SAS start-up statements field in the New Server wizard. For servers that have already been defined, include the LIBNAME statement in the Properties dialog box.
Assigning Libraries

When you view a SAS server in SAS Enterprise Guide or SAS Enterprise Guide Explorer, you see a list of libraries on the selected server. The list includes both libraries that are assigned (identified with a yellow icon) and libraries that are unassigned (identified with a white icon).

Assigned libraries are libraries that are pre-assigned or assigned in an autoexec program. Unassigned libraries are libraries that have been defined in metadata but have not yet been assigned or accessed. To assign an unassigned library, right-click on the library and select Assign. If the library definition was created by SAS Enterprise Guide Explorer, the library is assigned using the method that was specified in the library definition. Otherwise, the library is assigned using the META engine in its default mode, which means that the library is Read-Only. The library contents also match the metadata definition, so physical tables that are not defined in metadata are not displayed. Furthermore, tables and columns are not displayed if the user is not authorized to see that data.

Reset a Library Login

When you are prompted for credentials when connecting to a library, those credentials are stored in metadata so that they can be used later. The Reset login option clears these credentials, so you are prompted for credentials the next time you connect to the library.

**Note:** You cannot use this option on libraries that have been assigned using the metadata LIBNAME engine (MLE).

To reset the login for a library, right-click on the library name and select Reset login.

**Note:** When you use this option on a DBMS library where the DBMS credentials are stored in a shared group, the metadata identity removes the shared credentials, preventing access to the library for all users. Within the SAS Management Console, you can use the Reset login capability in the Options category to restrict users from accessing this option.
Manage Logins with SAS Enterprise Guide Explorer

To add, modify, or delete your logins, open SAS Enterprise Guide Explorer and select File ➤ Manage Logins. The Login Manager dialog box lists your current logins. You can edit an existing login or add a new one.

In the Edit Login dialog box, you select an authentication domain from a list of available domains. These domains are created in SAS Management Console.

Configure SAS Enterprise Guide for Integrated Windows Authentication

You can configure SAS Enterprise Guide to communicate with the SAS Metadata Server using Integrated Windows authentication. Within SAS Enterprise Guide, follow these steps:


2 Click File ➤ Manage Profiles ➤ Add.

3 Define a profile for the SAS Metadata Server by entering the Name, Machine, and Port. The Description is optional.

4 Click the Remote or Local button.

   **Note:** If SAS Enterprise Guide is on the same machine as the SAS Metadata Server, then do not select Local in the connection profile and define the SAS Metadata Server port. The fully qualified machine name in the Remote field must be used.

5 Click the Use Integrated Windows Authentication button. It is not necessary to configure the Advanced properties of the connection profile. The SAS Metadata Server accepts Kerberos connections and NTLM connections using the original...
service principal name (SPN) generated. To force only Kerberos connections, see “Forcing Kerberos” in SAS Intelligence Platform: Security Administration Guide.

6 Click Save. The Connections window appears. Verify that the SAS Metadata Server is listed. Click Close.

For more information, see “How to Configure Integrated Windows Authentication” in SAS Intelligence Platform: Security Administration Guide.

Configure SAS Enterprise Guide for Grid Computing

To configure a SAS grid to distribute the workload from SAS Enterprise Guide, use the SAS Grid Manager. For assistance, refer to Grid Computing in SAS.

You can use a SAS grid in the following ways:

- Send jobs to a load-balanced SAS Workspace Server, and specify grid as the load-balancing algorithm.

  **Note:** When SAS Workspace Servers are grid-launched, you should disable the grid options since the benefit of load-balancing has already been realized. To do this, specify a value of Ignore for the EGGridPolicy extended attribute.

- Specify that a project is to run on a grid, by specifying the option **Use grid if available** in the Project Properties dialog box.

- Specify that a task is to run on a grid, by specifying the option **Use grid if available** in the task’s Properties dialog box.

- On the logical grid server, specify a value of Force for the EGGridPolicy extended attribute to send all output from SAS Enterprise Guide to your grid. Or specify a value of Ignore for the extended attribute to never send jobs to the grid, regardless of the value of the **Use grid if available** option.

To run project submissions or tasks on separate grid nodes, select the project or task option **Allow parallel execution**. If parallel tasks or project submissions share data,
create pre-defined libraries on each grid node, and ensure that all tasks or project submissions write and read data from those libraries.

**Configure SAS Enterprise Guide for Parallel Execution**

The following features in SAS Enterprise Guide require the use of client-managed pooled SAS Workspace Servers:

- parallel execution of process flows
- Data Explorer, including Quick Stats

These features cause SAS Enterprise Guide to open new workspace server sessions to enable parallel execution. As the sessions become idle, they terminate.

The parallel workspace server sessions cooperate and store results files in a temporary shared results directory. Results files are retrieved from that directory for display by SAS Enterprise Guide. An example of a results file is a graph that is created by Quick Stats. The temporary shared results directory is deleted upon termination of the workspace server session.

The temporary shared results directory is created in a location that is subordinate to the path specified in the WORK= system option for the SAS Workspace Server.

In the z/OS operating environment, the WORK= system option must refer to a UNIX file system path to enable parallel execution of process flows and the Data Explorer. If the WORK= system option refers to a native MVS bound library, those features are disabled. The following specification places the WORK library in a UNIX file system directory: `WORK=/tmp`.

To configure a SAS Workspace Server with the WORK= system option, specify `WORK=/tmp` in the following file:

```
config-dir/Lev1/SASApp/WorkspaceServer/sasv9_usermods.cfg
```

If your pooled SAS Workspace Servers are configured under a single SAS Application Server, then you can set the WORK= system option once, in the following file:
To create client-enabled pooled SAS Workspace Servers, see the *SAS Intelligence Platform: Application Server Administration Guide*.

---

**Configure SAS Enterprise Guide to Access a Locked-Down SAS Server**

Six types of SAS servers can be configured to run in a high-security locked-down mode: workspace, pooled workspace, stored process, batch, grid, and SAS/CONNECT. When a server is locked down, it can access only specified resources on the host file system. The server also cannot run or invoke a number of SAS language elements that access the host file system.

To enable SAS Enterprise Guide to access a locked-down server, the default starting point needs to be a location that is enabled for access. To learn how to change the default starting point, and to learn more about locked-down servers, see the *SAS Intelligence Platform: Security Administration Guide*.

---

**Configure SAS Enterprise Guide to Turn Off the Automatic Check for Updates Feature**

To turn off the automatic check for updates feature, follow these steps:

1. On the task bar, click **Tools ▶ Options**. In the **General** tab, deselect **Automatically check for updates**.

2. Click **OK**.
Configure SAS Enterprise Guide to Hide the Check for Updates Option

The Check for Updates option is located in Help menu on the Task Bar.

If necessary, you can hide the Check for Updates option. Follow these steps to hide the option:

1. Create a backup copy of your SEGuide.exe.config file.
2. In the SEGuide.exe.config file, change the appSettings element by adding a CheckForUpdates key and false value as shown in the following code:

   <!-- Example application settings -->
   <appSettings>
     <add key="CheckForUpdates" value="false" />
   </appSettings>

3. Save the file.

If you hide the Check for Updates option using a configuration file, it disables both the automatic and the manual method of checking for updates.
Tasks That Require Other SAS Software

SAS Enterprise Guide includes tasks that require the use of other SAS software. The SAS Forecast Studio tasks require the installation of the SAS Forecast Server software. The Rapid Predictive Modeler task requires the installation of the SAS Enterprise Miner software.

To run the tasks that use SAS Forecast Server or SAS Enterprise Miner, your role requires certain capabilities. The capabilities are defined in “Default Roles and Capabilities for SAS Enterprise Guide” on page 126. Refer to the Time Series and Data Mining categories. Note that the Rapid Predictive Modeler task runs only on SAS 9.3 or 9.4 servers. The other tasks run on SAS 9.2, 9.3, or 9.4 servers.

Default Roles and Capabilities for SAS Enterprise Guide

As described in the SAS Intelligence Platform: Security Administration Guide, you can assign users to roles to provide access to selected capabilities in SAS Enterprise Guide.

Using SAS Management Console, as described in “Administering Roles” on page 165, you can assign users to roles, change the capabilities that are enabled by each role, and create new roles with unique sets of capabilities. You can also register new capabilities for custom tasks.

SAS Enterprise Guide provides four default roles named Advanced, OLAP, Analysis, and Programming. The following table defines the capabilities that are assigned by default to the four roles.

Usage notes for roles and capabilities:

- After you upgrade to a new release of SAS Enterprise Guide, you need to manually restore any non-default roles or capabilities that you created or selected in the previous release.
New capabilities were added in SAS Enterprise Guide 6.1. You might need to select additional capabilities to retain the same level of access that was provided by default in the 5.1 release. Review the new capabilities in the following table and select new capabilities for your roles as needed. In the table, 15 new capabilities and 3 changed descriptions are identified with an asterisk (*) in the Capability column. Most of the new capabilities appear in the Save or Distribute category.

In the first maintenance release of SAS Enterprise Guide 6.1, four new capabilities were added, which are identified with two asterisks (**) in the Capability column.

In the SAS Enterprise Guide 7.1 release, seven new capabilities were added, which are identified with three asterisks (***”) in the Capability column.

### Table 6.2 Default Capabilities Assigned to Roles for SAS Enterprise Guide

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced</th>
<th>OLAP</th>
<th>Analysis</th>
<th>Programming</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open or Import Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*** Browse LASR Libraries</td>
<td>Browse libraries that use the SASIOLA engine.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Import Data</td>
<td>Perform the Import Data task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Open Cube from OLAP Server</td>
<td>Navigate to OLAP cubes or open cube source data.</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Open Data from Exchange</td>
<td>Use menus and process flow diagrams to open files in Microsoft Exchange.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Data from ODBC</td>
<td>Use menus and process flow diagrams to open data sources using an ODBC provider.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Data from OLEDB</td>
<td>Use menus and process flow diagrams to open files using an installed OLE DB provider.</td>
<td>Advanced X OLAP X Analysis X Programming X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Files from Local Computer</td>
<td>Use the Open File dialog box to navigate, drag, copy, and paste. Not a substitute for system security.</td>
<td>X X X X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Files from SAS Server</td>
<td>View the server in the tree, navigate to the server, and open or import files. Not a substitute for system security.</td>
<td>X X</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Save or Distribute Category**

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>*** Track Program History</td>
<td>Track changes made to SAS programs over time.</td>
<td>Advanced X OLAP X Analysis X Programming X</td>
</tr>
<tr>
<td>Copy and Paste SAS Server Content</td>
<td>Use menus to copy and paste or drag and drop from SAS servers and libraries. Not a substitute for system security.</td>
<td>X X X</td>
</tr>
<tr>
<td>` Export Data to Local Computer</td>
<td>Export data to the local file system. This is not a substitute for system security.</td>
<td>X X X</td>
</tr>
<tr>
<td>` Export Data to SAS Server</td>
<td>Export data to the SAS server file system. This is not a substitute for system security.</td>
<td>X</td>
</tr>
</tbody>
</table>

128 Chapter 6 / Administering SAS Enterprise Guide
<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify Output Data Location in SAS Tasks</td>
<td>Modify the metadata authorization settings for folders.</td>
<td>X</td>
</tr>
<tr>
<td>Print Data and Results</td>
<td>Print data and results.</td>
<td>X</td>
</tr>
<tr>
<td>Publish to Distribution Channel</td>
<td>Use the Publish menu to create or modify a publish wizard that sends content to distribution channels such as Email or Web.</td>
<td>X</td>
</tr>
<tr>
<td>Save Files to Local Computer</td>
<td>Save a file to the local file system. This is not a substitute for system security.</td>
<td>X</td>
</tr>
<tr>
<td>Save Files to SAS Server</td>
<td>Save a file to the SAS server file system. This is not a substitute for system security.</td>
<td>X</td>
</tr>
<tr>
<td>Save Program to Local Computer</td>
<td>Save or export a program to the local file system. This is not a substitute for system security.</td>
<td>X</td>
</tr>
<tr>
<td>Save Program to SAS Server</td>
<td>Save or export a program to the SAS server file system. This is not a substitute for system security.</td>
<td>X</td>
</tr>
<tr>
<td>Save Project to Local Computer</td>
<td>Save a project to a SAS folder. This is not a substitute for system security.</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>*Save Project to SAS Server</td>
<td>Save a project to the SAS server file system. This is not a substitute for system security.</td>
<td>X</td>
</tr>
<tr>
<td>Save to SAS Folder</td>
<td>Save a project to a SAS folder.</td>
<td>X</td>
</tr>
<tr>
<td>Send Content to Email Recipient</td>
<td>Use the Publish menu options Email Recipient and Email Recipient as a Step in Project to modify a wizard that distributes files using email.</td>
<td>X</td>
</tr>
<tr>
<td>*Send SAS Content to Internet Explorer</td>
<td>Send SAS content to Internet Explorer.</td>
<td>X</td>
</tr>
<tr>
<td>*Send SAS Content to JMP</td>
<td>Send SAS content to JMP software.</td>
<td>X</td>
</tr>
<tr>
<td>Send SAS Content to Microsoft Office</td>
<td>Send SAS content to Microsoft Office applications.</td>
<td>X</td>
</tr>
<tr>
<td>Content Category</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add or Modify Custom Code to SAS Task</td>
<td>Create or modify SAS code in SAS Enterprise Guide tasks.</td>
<td>X</td>
</tr>
<tr>
<td>Analyze for Grid Computing</td>
<td>Analyze a SAS program and create a new version that is optimized for the SAS Grid Computing environment.</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Analyze for Program Flow</td>
<td>Analyze a SAS program and create a new process flow from the results.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Create or Modify Advanced Query</td>
<td>Use the <strong>Query Builder</strong> menu option to create or modify advanced queries.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Create or Modify Data Join in Advanced Query</td>
<td>Use the <strong>Add Table</strong> and <strong>Join</strong> menu options to create or modify table joins in advanced queries.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Create or Modify SAS Program</td>
<td>Open, create, and modify SAS code nodes in projects. If not granted, users can still execute SAS programs.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Create or Modify SAS Stored Process</td>
<td>Use the menu options <strong>Create Stored Process</strong> and <strong>Write TaskCode to Stored Process</strong> to create or modify stored processes in SAS Enterprise Guide projects.</td>
<td>Advanced</td>
</tr>
</tbody>
</table>

**Options Category**

<table>
<thead>
<tr>
<th>Allow HTML Result Format</th>
<th>Generate results in HTML format.</th>
<th>Advanced</th>
<th>OLAP</th>
<th>Analysis</th>
<th>Programming</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Parallel Execution on the Same Server</td>
<td>Enable or disable parallel execution on the same server.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------</td>
<td>------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>‘Allow PDF Result Format</td>
<td>Generate results in PDF format.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>‘Allow RTF Result Format</td>
<td>Generate results in RTF format.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Modify All Options</td>
<td>Modify all options in the Options dialog box. When not granted, users can view options.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Modify Email Options</td>
<td>Change email options for projects. When not granted, users can view email options.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Modify Metadata Authorization</td>
<td>Modify the metadata authorization settings for folders.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Performance Options</td>
<td>Change performance options for projects. When not granted, users can view performance options.</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Modify SAS Server Reference in Project or Document</td>
<td>Use the Select Server menu option to change the internal server reference for all projects that run on the server.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Modify Security Options</td>
<td>Change security options for projects. When not granted, users can view security options.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset Login</td>
<td>Remove the login from metadata associated with a server or library.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
<td>----------</td>
<td>------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Tools and Help Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access Project Maintenance</td>
<td>Open the Project Maintenance dialog box to rename servers and libraries throughout a project.</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access SAS Enterprise Guide Explorer</td>
<td>Use the <strong>Enterprise Guide Explorer</strong> menu option to open the explorer, or run the executable file from the operating environment.</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*** Access SAS Macro Variable Viewer</td>
<td>Use the SAS Macro Variable Viewer tool, which is a convenient way to view SAS Macro variables and their values.</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>*** Access SAS Studio Tasks</td>
<td>Access SAS Studio tasks.</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Access SAS Technical Support</td>
<td>Use the menu options under <strong>SAS on the Web</strong> to navigate to the SAS Technical Support Website from SAS Enterprise Guide.</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>*** Access System Options Viewer</td>
<td>Use the System Options Viewer tool, which is a convenient way to view SAS system options.</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access Unregistered Custom Tasks</td>
<td>Edit or run custom tasks that are not registered in SAS metadata (unless the task is otherwise disallowed).</td>
<td>Advanced: X, OLAP: X, Analysis: X, Programming: X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assign Project Library</td>
<td>Perform the Assign Project Library task.</td>
<td>Role: X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Browse Stored Process Server File System</td>
<td>Browse the file system on stored process servers using the SAS Enterprise Guide Explorer application.</td>
<td>Role: X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create or Modify Schedules</td>
<td>Use the Schedule Project and Schedule Process Flow menu options to create and modify schedule projects. When not granted, users can view schedules.</td>
<td>Role: X, OLAP: X, Analysis: X, Programming: X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JMP Stored Process Packager</td>
<td>Define additional content for a SAS stored process that runs within JMP.</td>
<td>Role: X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Styles</td>
<td>Use the Style Manager menu option to modify the styles that are used to create reports.</td>
<td>Role: X, OLAP: X, Analysis: X, Programming: X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>----------</td>
<td>------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Data Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Append Tables</td>
<td>Perform the Append Tables task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Compare Data</td>
<td>Perform the Compare Data task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Create Format</td>
<td>Perform the Create Format task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Create Format from a Data Set</td>
<td>Create a SAS format using information in a SAS data set.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cut and Paste Table Data</td>
<td>Perform the cut and copy of table data.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Data Set Attributes</td>
<td>Perform the Compare Data task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Delete Data Sets and Formats</td>
<td>Perform the Delete Data Sets and Formats task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Download Data Files to PC</td>
<td>Perform the Download Data Files to PC task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Edit Data Sets</td>
<td>Change the values and column properties of a data set in the data grid.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Explore Data</td>
<td>Explore data in the interactive data explorer.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Extract Data from SAS Visual Analytics Reports</td>
<td>Extract the data contained in a SAS Visual Analytics report.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------</td>
<td>----------</td>
<td>------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Import JMP</td>
<td>Import a JMP file</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Import SPSS</td>
<td>Import an SPSS file</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Import Stata</td>
<td>Import a Stata file</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Quick Stats</td>
<td>Show Quick Stats</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Random Sample</td>
<td>Perform the Random Sample task</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Rank</td>
<td>Perform the Rank task</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Sort Data</td>
<td>Perform the Sort Data task</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Split Columns</td>
<td>Perform the Split Columns task</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Stack Columns</td>
<td>Perform the Stack Columns task</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Standardize Data</td>
<td>Perform the Standardize Data task</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Transpose</td>
<td>Perform the Transpose task</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Upload Data Files to Server</td>
<td>Perform the Upload Data Files to Server task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>&quot; Upload to LASR</td>
<td>Load a data source into a SAS LASR Analytics server.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Describe Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Characterize Data</td>
<td>Perform the Characterize Data task</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------</td>
<td>-----------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Distribution Analysis</td>
<td>Perform the Distribution Analysis task.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>List Data</td>
<td>Perform the List Data task.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>One-Way Frequencies</td>
<td>Perform the One-Way Frequencies task.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Summary Statistics</td>
<td>Perform the Summary Statistics task.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Summary Tables</td>
<td>Perform the Summary Tables task.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Table Analysis</td>
<td>Perform the Table Analysis task.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>Graph Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Area Plot</td>
<td>Perform the Area Plot task.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Bar Chart</td>
<td>Perform the Bar Chart task.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Bar-Line Chart</td>
<td>Perform the Bar-Line Chart task.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Box Plot</td>
<td>Perform the Box Plot task.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Bubble Plot</td>
<td>Perform the Bubble Plot task.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Contour Plot</td>
<td>Perform the Contour Plot task.</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------</td>
<td>------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Donut Chart</td>
<td>Perform the Donut Chart task.</td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programming</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line Plot</td>
<td>Perform the Line Plot task.</td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programming</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Map Chart</td>
<td>Perform the Map Graph task.</td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programming</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open ODS Graphics Designer</td>
<td>Open the ODS Graphics Designer.</td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programming</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pie Chart</td>
<td>Perform the Pie Chart task.</td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programming</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Radar Chart</td>
<td>Perform the Radar Chart task.</td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programming</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scatter Plot</td>
<td>Perform the Scatter Plot task.</td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programming</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scatter Plot Matrix</td>
<td>Create a matrix of scatter plots.</td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programming</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show ODS Statistical Graph</td>
<td>Show ODS Statistical Graph from an SGD file.</td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programming</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surface Plot</td>
<td>Perform the Surface Plot task.</td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programming</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tile Chart</td>
<td>Perform the Tile Chart task.</td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programming</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ANOVA Category</strong></td>
<td></td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linear Models</td>
<td>Perform the Linear Models task.</td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programming</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mixed Models</td>
<td>Perform the Mixed Models task.</td>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OLAP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Analysis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Programming</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Regression Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Multivariate Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------</td>
<td>------</td>
<td>----------</td>
<td>------</td>
<td>----------</td>
</tr>
<tr>
<td>Canonical Correlation</td>
<td>Perform the Canonical Correlation task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cluster Analysis</td>
<td>Perform the Cluster Analysis task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Correlations</td>
<td>Perform the Correlations task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Discriminant Analysis</td>
<td>Perform the Discriminant Analysis task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Factor Analysis</td>
<td>Perform the Factor Analysis task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Principal Components</td>
<td>Perform the Principal Components task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Survival Analysis Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Life Tables</td>
<td>Perform the Life Tables task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Proportional Hazards</td>
<td>Perform the Proportional Hazards task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CDF Plots</td>
<td>Perform the CDF Plots task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Histograms</td>
<td>Perform the Histograms task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P-P Plots</td>
<td>Perform the P-P Plots task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Probability Plots</td>
<td>Perform the Probability Plots task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced</td>
<td>OLAP</td>
<td>Analysis</td>
<td>Programming</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>--------------------------------------------------</td>
<td>----------</td>
<td>------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Q-Q Plots</td>
<td>Perform the Q-Q Plots task.</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Control Charts Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Box Chart</td>
<td>Perform the Box Chart task.</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>c Chart</td>
<td>Perform the c Chart task.</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Individual Measurements Chart</td>
<td>Perform the Individual Measurements Chart task.</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mean and Range Chart</td>
<td>Perform the Mean and Range Chart task.</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mean and Standard Deviation Chart</td>
<td>Perform the Mean and Standard Deviation Chart task.</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>np Chart</td>
<td>Perform the np Chart task.</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>p Chart</td>
<td>Perform the p Chart task.</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>u Chart</td>
<td>Perform the u Chart task.</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Pareto Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pareto Chart</td>
<td>Perform the Pareto Chart task.</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Time Series Category</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Role</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ARIMA Modeling and Forecasting</td>
<td>Perform the ARIMA Modeling and Forecasting task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basic Forecasting</td>
<td>Perform the Basic Forecasting task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Time Series Data</td>
<td>Perform the Create Time Series Data task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forecast Studio Create Project</td>
<td>Perform the Forecast Studio Create Project task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forecast Studio Open Project</td>
<td>Perform the Forecast Studio Open Project task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forecast Studio Override Project</td>
<td>Perform the Forecast Studio Override Project task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prepare Time Series Data</td>
<td>Perform the Prepare Time Series Data task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Regression Analysis of Panel Data</td>
<td>Perform the Regression Analysis of Panel Data task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Regression Analysis with Autoregressive Errors</td>
<td>Perform the Regression Analysis with Autoregressive Errors task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Mining Category</td>
<td>Model Scoring</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Table: Role Requirements for SAS Enterprise Guide*
<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rapid Predictive Modeler</td>
<td>Create a predictive model using SAS Enterprise Miner procedures.</td>
<td>Advanced</td>
</tr>
<tr>
<td>Recency, Frequency, and Monetary Analysis</td>
<td>Identify existing customers who are most likely to respond to a new campaign or product offer.</td>
<td>Analysis</td>
</tr>
</tbody>
</table>

### Registering Custom Tasks as Capabilities in SAS Enterprise Guide

#### Overview

Custom add-in tasks are .NET assemblies (DLL files) that you create, deploy, register in SAS Enterprise Guide, and execute from the SAS Enterprise Guide task list or add-in menu.

To provide access to custom tasks based on the job responsibilities, you can register custom tasks as capabilities, assign capabilities to roles, and assign users to roles.

#### Create Custom Tasks

To create custom tasks, you develop Windows executables and package them as .NET assemblies. It is convenient to assemble multiple tasks in a single .NET assembly so that you can share code and implementation among the tasks. For additional information, sample DLLs, and sample executable source files, see the topic “Creating Custom Add-In Tasks for SAS Enterprise Guide,” at [http://support.sas.com/documentation/onlinedoc/guide/custommtasks/](http://support.sas.com/documentation/onlinedoc/guide/custommtasks/).
Deploy Custom Tasks

You can deploy custom tasks to SAS Enterprise Guide computers in two ways, using drop-in deployment or add-in deployment. Drop-in deployment copies .NET assemblies into local directories that are recognized by SAS Enterprise Guide. Custom tasks in drop-in directories are automatically registered (made available for execution) the next time the user starts SAS Enterprise Guide.

Add-in deployment copies .NET assemblies into any local directory. You then identify those directories in SAS Enterprise Guide using the Add-In Manager to make those tasks available for execution.

When you deploy, make sure that you include any dependent assemblies that are referenced by your custom tasks. Make sure that you do not include any dependent assemblies that are provided by SAS Enterprise Guide or the SAS Add-In for Microsoft Office.

Follow these steps to use the Add-In Manager:

1. Copy the .NET assembly into one of the following directories:
   - C:\Program Files\SAS\EnterpriseGuide\version\Custom
   - %appdata%\SAS\EnterpriseGuide\version\Custom
     %appdata% is the Microsoft Windows environment variable that maps to a user account. Repeat the copy in other user accounts if multiple users run SAS Enterprise Guide on the same host.
   - %appdata%\SAS\SharedSettings\version\Custom
     Use this method to deploy custom tasks to specified user accounts, using a shared directory that is accessed by both SAS Enterprise Guide and the SAS Add-In for Microsoft Office.


3. Test the new custom tasks by selecting View ▶ Task List or Tools ▶ Add-In.
Follow these steps to use add-in deployment:

1. Copy the .NET assembly into any local directory.
2. In SAS Enterprise, start the Add-In Manager. Select Tools ▶ Add-In ▶ Add-In Manager.
3. In the Add-In Manager dialog box, select Browse.
4. Navigate to the directory where you stored your .NET assembly.
5. Click Open to display the names of the custom tasks in the assembly.
6. Click OK to accept the custom tasks and register them in SAS Enterprise Guide.
7. Test the new custom tasks by selecting View ▶ Task List or Tools ▶ Add-In.

Register Custom Tasks as Capabilities

After you deploy custom tasks, follow these steps to register custom tasks as capabilities:

2. In Explorer, select Tools ▶ Task Import Wizard.
3. In the first page of the Task Import Wizard, you see your current metadata profile connection. If you need to connect with a different profile, click Cancel to close the wizard and select File ▶ Manage Profiles. After you change your profile, click Close, and then start the Task Import Wizard.
4. In the second page of the Task Import Wizard, select All known locations on this computer. Selecting this option ensures that the custom tasks that you registered with the Add-In Manager is registered in metadata by Task Import Wizard.

To find custom tasks, the Task Import Wizard looks for the file AddInRegistry.xml, which is created by the Add-In Manager. If you selected Common registry in the
Add-In Manager, then the path to AddInRegistry.xml is: C:\ProgramData\SAS\BIClientTasks\4\AddInRegistry. If you selected User registry in the Add-In Manager, then the path to AddInRegistry.xml is: C:\Users\your-user-ID\AppData\Roaming\SAS\BIClientTasks\4\AddInRegistry.

5 Select tasks to receive metadata, and then click Finish in the sixth wizard page to create metadata.

If you are unable to create metadata, then you might need to install the package named SAS Enterprise Guide Server Data on the host that contains your current metadata repository.

Apply Custom-Task Capabilities to Roles

Follow these steps to apply custom-task capabilities to roles:

1 In SAS Management Console, open the User Manager.

2 To create a new role for your custom-task capabilities, right-click in the User Manager and select New ➤ Role.

3 To add a custom-task capability to an existing role, double-click an Enterprise Guide role.

4 In the role properties dialog box, click the Capabilities tab.

5 Expand the Plug-Ins branch in the tree view.

6 Click the custom-task capabilities that you want to add to that role.

7 Click OK.

The custom-task capabilities will be applied to the role the next time affected users initialize SAS Enterprise Guide.
SAS Enterprise Miner Overview for Administrators

SAS Enterprise Miner uses process flows to analyze enterprise data, create predictive and descriptive models, and interpret the models. The process flows are generated in a graphical user interface that enables interaction between statistical analysts, IT professionals, and business analysts.

Administrative Tasks in SAS Enterprise Miner

SAS Enterprise Miner can require the following administrative tasks:

- install and configure desktop applications
- install and configure a mid-tier SAS analytics server
- create and administer connection profiles
- define server connections
- configure an HTTP server to distribute model packages
- use the SAS Enterprise Miner plug-in for SAS Management Console
- monitor log files on the SAS analytics server

Information about these and all other administrative tasks for SAS Enterprise Miner are described in SAS *Enterprise Miner: Administration and Configuration*. 
Administering SAS Information Map Studio

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Information Map Studio Overview for Administrators</td>
<td>150</td>
</tr>
<tr>
<td>Add Users to SAS Information Map Studio</td>
<td>151</td>
</tr>
<tr>
<td>Register Resources as Input to SAS Information Maps</td>
<td>151</td>
</tr>
<tr>
<td>Tables, Cubes, and Stored Processes</td>
<td>151</td>
</tr>
<tr>
<td>User-Defined Formats</td>
<td>152</td>
</tr>
<tr>
<td>Access Control for SAS Information Maps</td>
<td>152</td>
</tr>
<tr>
<td>Overview</td>
<td>152</td>
</tr>
<tr>
<td>Access Control for Sets of Information Maps</td>
<td>153</td>
</tr>
<tr>
<td>Pooled Workspace Server</td>
<td>153</td>
</tr>
<tr>
<td>Log Files</td>
<td>154</td>
</tr>
<tr>
<td>Application Log</td>
<td>154</td>
</tr>
<tr>
<td>Resource Replacement Log</td>
<td>155</td>
</tr>
<tr>
<td>Copy to Folder Log</td>
<td>155</td>
</tr>
<tr>
<td>Memory Allocation</td>
<td>156</td>
</tr>
<tr>
<td>Configuration File</td>
<td>156</td>
</tr>
</tbody>
</table>
SAS Information Map Studio Overview for Administrators

SAS Information Map Studio provides a point-and-click interface for the creation and maintenance of information maps. Information maps are metadata definitions of enterprise data that provide a basis for querying and reporting.

After you install SAS Information Map Studio, certain administrative tasks need to be completed. The administrative tasks are summarized in the following table.

Table 8.1  Administrative Tasks for SAS Information Map Studio

<table>
<thead>
<tr>
<th>Administrative Task</th>
<th>Purpose of Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add users</td>
<td>Create a SAS identity for each person who uses the SAS environment.</td>
</tr>
<tr>
<td>Register resources</td>
<td>Make tables, SAS OLAP cubes, and stored processes available for the creation of SAS Information Maps.</td>
</tr>
<tr>
<td>Administer access control</td>
<td>Restrict access to resources in accordance with your security goals</td>
</tr>
<tr>
<td>Introduce pooled workspace servers</td>
<td>Enable server-side pooling for relational databases.</td>
</tr>
<tr>
<td>Administer log files</td>
<td>Specify the name and location of log files, how to modify the information that is recorded, and how to change the name and the location of the log file.</td>
</tr>
<tr>
<td>Change or view the application properties</td>
<td>Specify the name and location of the file.</td>
</tr>
</tbody>
</table>
Add Users to SAS Information Map Studio

The tasks for adding regular users are specific to SAS Information Map Studio. To access data through an information map, the user must have Read permission and ReadMetadata permission on the information map. Users must have an individual identity other than PUBLIC to log on to SAS Information Map Studio.

For considerations and instructions about setting-up information map users, refer to the following topics:

- “Administering Connection Profiles for Desktop Applications” on page 6
- “Add Regular Users” in SAS Intelligence Platform: Security Administration Guide

Register Resources as Input to SAS Information Maps

Tables, Cubes, and Stored Processes

SAS Information Map Studio accesses tables, cubes, and stored processes through the SAS Metadata Server. These resources are available only if they are registered in the metadata.

The following restrictions apply to these resources:

- Tables must be uniquely named and must be associated with a library that is assigned to a SAS Application Server. The tables can be any combination of SAS data sets and third-party relational database tables.

- SAS OLAP cubes must be uniquely named and must be associated with an OLAP schema that is assigned to a SAS Application Server.
Stored processes must be on the same SAS Application Server as the tables that are used by the information map. The stored process must be hosted by a SAS Workspace Server.

User-Defined Formats

If you have existing SAS data sets, you might also have a catalog of user-defined formats and informats. You have two options for making these formats available to applications such as SAS Information Map Studio:

- Give the format catalog a standard name and place it in an expected location. This is the preferred method.
- Create a user-defined formats configuration file, and use the FMTSEARCH system option to point to the format catalog.

For detailed instructions about both options, see “Connecting to Common Data Sources” in SAS Intelligence Platform: Data Administration Guide.

Access Control for SAS Information Maps

Overview

Information maps inherit permissions from their folders. The folders in turn inherit permissions from their parent folders. Folder permissions are not set in SAS Information Map Studio. Permissions can be applied in SAS Information Map Studio to SAS Information Maps within a folder.

WriteMetadata permission is needed on the information map to modify permissions or view any authorization-based prefilter assignments.

You can also apply BI row-level permissions through information maps. For details about BI row-level permissions, see “What Implementations are Available?” in SAS Intelligence Platform: Security Administration Guide.
To define access to an information map from within SAS Information Map Studio:

1. Open an information map or, if working with an unsaved information map, save it.
3. Modify the permission settings as necessary.
4. Close the dialog box.
5. Save the information map for the changes to take effect.

For additional information, see the SAS Information Map Studio Help and Chapter 2, “Common Elements,” on page 5.

**Access Control for Sets of Information Maps**

Proper storage of information maps enables you to easily do the following:

- manage the access controls for sets of information maps
- ensure that the information maps are available as resources for queries and report writing

To manage the access controls for sets of information maps, create subfolders under SAS Folders in the Folders tab of SAS Management Console. For example, you can add a folder for Human Resources and set access controls so that the Human Resources user group has exclusive access to the Human Resources information map folder. The folder's access controls are inherited by all of the information maps within that folder.

---

**Pooled Workspace Server**

You can use SAS Information Map Studio to support server-side pooling for relational databases. The use of this server pool is governed by the authentication rules that are
set in the SAS Metadata Server. A pooled workspace server is configured in the library's information maps that include queries of relational databases.

Information maps that include queries of relational databases are intended to run on a SAS Pooled Workspace Server.

If a pooled workspace server is not defined or available, the query attempts to use a SAS Workspace Server.

**Note:** OLAP-defined information maps and the queries are always run on the OLAP server.

For detailed information about workspace server pooling, see “Load Balancing and Pooling” in the *SAS Intelligence Platform: Application Server Administration Guide*.

---

**Log Files**

**Application Log**

SAS Information Map Studio records selected events that occur while running the application. Error data for specific components or Java packages are recorded. In order to record diagnostic information, your application must have Write access to the log file on the operating system’s file system.

To change the information that is recorded, or to change the name or location of the log file, follow these steps:

1. **Exit the application.**
2. **Open** `SAS-installation-directory\SAS\SASInformationMapStudio\4.4\mapstudio.ini`
3. **Add** `-loggingSetupDialog` **to the end of the MainClass statement, save, and close the file.**
4. **Start the application.** The Diagnostic Settings dialog box is displayed.
5 In the **Severity level** drop-down list, select the severity level for recording information for the entire application.

6 (Optional) Record a different level of information for a particular component or Java package. Select the **Component** or **Java package** to specify the **Severity level**.

7 The **Log file** box specifies the output log file that stores the error data. Set a new file or location, as needed.

8 Select **OK** to begin using the new diagnostic settings.

In general, it is best to modify this file under the direction of SAS Technical Support.

For additional information, see “Administering Logs and Other Local Files” on page 11 and the SAS Information Map Studio Help.

**Note:** If you run your application on a Citrix server, then the log file is located on the Citrix server machine.

**Resource Replacement Log**

Information map resources can be replaced after an information map is created. The Resource Replacement dialog box is used to replace external metadata resources that are referenced by the information map. The application records to the log file the replacement tasks that were performed, and any issues that were encountered.

For additional information, see SAS Information Map Studio Help.

**Copy to Folder Log**

When the Copy to Folder feature in the resource pane is used, a copy-paste log file is generated to record the events.

The Windows Log File location is `C:\Documents and Settings\User Id\Application Data\SAS\Logs`.

The Vista Log File location is `C:\Users\User Id\AppData\Roaming\SAS\Logs`. 
Memory Allocation

SAS Information Map Studio dynamically allocates memory to support its user interface. For additional information, see “Managing the Java Heap Used by Desktop Applications” on page 12.

Configuration File

The configuration file for SAS Information Map Studio is located in the default installation directory `SAS\SASInformationMapStudio\4.4\`. The name of the file is `mapstudio.ini`. Each installation of the SAS Information Map Studio application has its own configuration file.

Note: In general, it is best to modify this file under the direction of SAS Technical Support.
## Administering SAS Management Console

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Management Console Overview for Administrators</td>
<td>158</td>
</tr>
<tr>
<td>Quick Reference for SAS Management Console</td>
<td>158</td>
</tr>
<tr>
<td>Understanding the Configuration of SAS Management Console</td>
<td>161</td>
</tr>
<tr>
<td>Redirecting Local Files Created by SAS Management Console</td>
<td>162</td>
</tr>
<tr>
<td>Starting SAS Management Console</td>
<td>162</td>
</tr>
<tr>
<td>- Overview</td>
<td>162</td>
</tr>
<tr>
<td>- Specify Java Options</td>
<td>163</td>
</tr>
<tr>
<td>- Specify the Plug-in Location</td>
<td>163</td>
</tr>
<tr>
<td>Administering Connection Profiles in SAS Management Console</td>
<td>164</td>
</tr>
<tr>
<td>About the Folders Tab</td>
<td>164</td>
</tr>
<tr>
<td>Administering Roles</td>
<td>165</td>
</tr>
</tbody>
</table>
SAS Management Console Overview for Administrators

SAS Management Console is the primary administrative interface for the SAS Intelligence Platform. Use it to manage servers, libraries, security, metadata objects, roles, logs, backup and recovery, scheduling, and message queues.

Because of its powerful capabilities, you should limit the number of clients that receive SAS Management Console. Grant administrative permissions only to trusted and experienced individuals. Also consider the use of roles to prevent users from seeing plug-ins that do not apply to their jobs. For example, a user can be given a role that displays the Library Manager without displaying the Server Manager or the User Manager.

SAS Management Console is structured as a series of Java plug-ins, each of which provide a specific administrative function. A number of plug-ins are delivered to all customers, such as the Server Manager plug-in. Other plug-ins are delivered based on your site license, such as the administrative plug-in for SAS Enterprise Miner.

Quick Reference for SAS Management Console

Each plug-in in SAS Management Console has its own set of Help information. To access plug-in Help, either click a Help button in a window or select the plug-in in the Plug-ins tab and choose the Help from the Help menu.

The following table lists tasks and related components in SAS Management Console:
<table>
<thead>
<tr>
<th>Task</th>
<th>Component</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage permissions for users and groups.</td>
<td>Authorization Manager, Access Control Templates folder</td>
<td>See the SAS Management Console: Guide to Users and Permissions.</td>
</tr>
<tr>
<td>Manage connection profiles, domains, and Integrated Windows authentication.</td>
<td>Connection Profile Wizard</td>
<td>See the Help for the Connection Profile Wizard. Select File ➤ Connection Profile and click Help.</td>
</tr>
<tr>
<td>Create and register libraries.</td>
<td>Data Library Manager</td>
<td>See the SAS Intelligence Platform: Data Administration Guide.</td>
</tr>
<tr>
<td>Manage services, including web application logs, connections, discovery, events, sessions, security, and stored processes.</td>
<td>Foundation Services</td>
<td>See the Help for Foundation Services in SAS Management Console.</td>
</tr>
<tr>
<td>Control servers and manage initialization, log configuration, and options.</td>
<td>Server Manager</td>
<td>See the SAS Intelligence Platform: System Administration Guide.</td>
</tr>
<tr>
<td>Manage users and roles.</td>
<td>User Manager</td>
<td>See the SAS Intelligence Platform: Security Administration Guide and the SAS Management Console: Guide to Users and Permissions.</td>
</tr>
<tr>
<td>Create and import packages, transfer data between folders.</td>
<td>Folders tab</td>
<td>See the Help for SAS Management Console.</td>
</tr>
<tr>
<td>Task</td>
<td>Component</td>
<td>Reference</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------------------</td>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Register and manage metadata objects, configure libraries, tables, jobs, stored processes, and so on.</td>
<td>Folders tab</td>
<td>See Help on Folders in SAS Management Console.</td>
</tr>
<tr>
<td>Manage, replicate, backup, and restore the SAS Metadata Server and resource templates.</td>
<td>Metadata Manager</td>
<td>See the SAS Intelligence Platform: System Administration Guide.</td>
</tr>
<tr>
<td>Create and manage flows, execute jobs with available dependencies.</td>
<td>Schedule Manager</td>
<td>See Scheduling in SAS.</td>
</tr>
<tr>
<td>Manage and monitor custom applications.</td>
<td>Foundation Services Manager, Application Monitor, Configuration Manager</td>
<td>See the Help for these plugins.</td>
</tr>
<tr>
<td>Manage the Web Infrastructure Platform.</td>
<td>Configuration Manager</td>
<td>See the SAS Intelligence Platform: Web Application Administration Guide.</td>
</tr>
<tr>
<td>Test deployments.</td>
<td>Deployment Tester</td>
<td>See &quot;Monitoring Applications&quot; in SAS Management Console Help. Also see &quot;Validating Logical Servers&quot; in SAS Management Console Help.</td>
</tr>
</tbody>
</table>
### Task
Define geographic maps and import services. Under separate license, works with ArcGIS software to embed OLAP data in geographic displays.

### Component
Map Service Manager

### Reference
See the SAS Intelligence Platform: Web Application Administration Guide.

---

**Understanding the Configuration of SAS Management Console**

The following administrative and configuration files for SAS Management Console are located on each client:

**sasmc.ini**
- contains configuration settings for SAS Management Console. The default storage location is `SAS-installation-directory\SAS\SASManagementConsole\9.x`.

**app.smc**
- contains the user profile for SAS Management Console. The default storage location for Windows is `C:\Documents and Settings\user-name\Application Data\SAS\SASManagementConsole\9.x`. The default storage location for the Vista operating environment begins with `C:\Users\user-name\AppData\Roaming\SAS\9.x`. 
Redirecting Local Files Created by SAS Management Console

By default, SAS Management Console stores the log files, application default files, and connection profiles on the local host. To change the default storage location, follow these steps:

1. Close SAS Management Console on the local host.
2. Create the path and directory for the client files.
3. Open the file sasmc.ini and add the following Java argument:
   ```
   JavaArgs_xx=-Dsas.appdatapath="new-path"
   ``
   - `xx` is the next available Java argument number.
   - `new-path` is a fully qualified path to the new directory. Here is a typical example:
   ```
   JavaArgs_12=-Dsas.appdatapath="\\adminServer02\SMCClientFiles\Hostd17362"
   ```
4. Start SAS Management Console on the local host.

Starting SAS Management Console

Overview

In the Windows operating environment, you can start SAS Management Console by selecting **Start ▶ Programs ▶ SAS ▶ SAS Management Console**. You can also start the application from a command line. Navigate to the SAS Management Console installation directory and issue the command for your platform, as listed in the following table.
Table 9.2  SAS Management Console Start-up Commands

<table>
<thead>
<tr>
<th>Platform</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>sasmc.exe</td>
</tr>
<tr>
<td>64-bit enabled Solaris</td>
<td>./sasmc</td>
</tr>
<tr>
<td>64-bit enabled AIX</td>
<td>./sasmc</td>
</tr>
</tbody>
</table>

If you do not specify any options, SAS Management Console uses the parameters specified in the sasmc.ini file. The following sections contain information about options that you can specify on the command line or add to the sasmc.ini file.

Specify Java Options

To specify Java options when you start SAS Management Console, add JavaArgs_ lines to your sasmc.ini file. For example, to start SAS Management Console using the Japanese language, add the following lines to smc.ini:

```
JavaArgs_13=-Duser.language=ja
JavaArgs_14=-Duser.country=JP
```

Specify the Plug-in Location

By default, SAS Management Console looks for plug-ins in a plugins directory under the directory in which the application was installed. If you are starting SAS Management Console from another location, open sasmc.ini and locate the MainClass entry. Add pluginsDir as an option to MainClass, as shown in the following example:

```
MainClass=com.sas.console.visuals.MainConsole -pluginsDir "C:\plugins"
```
Administering Connection Profiles in SAS Management Console

During initialization, SAS Management Console connects to a SAS Metadata Server that is identified in a connection profile. You need to create one profile for each SAS Metadata Server if you have more than one. You might also need to create separate profiles if you want to connect as an administrator or as the unrestricted user. For information about the creation of connection profiles, see “Administering Connection Profiles for Desktop Applications” on page 6.

About the Folders Tab

The **Folders** tab provides a categorized folder tree that displays the objects that have been registered in metadata on the currently connected SAS Metadata Server. In the **Folders** tab that you can do the following:

- create new stored processes
- import and export folders and metadata objects
- delete folders and metadata objects
- display and modify the properties and permissions of folders and metadata objects

These actions are made available depending on your current set of permissions.

Some of the top-level folders have Content Mapping properties. These properties determine whether additions and deletions relate to metadata definitions only, or to metadata definitions and their respective physical files. By default, additions and deletions affect metadata objects only. Administrators can set Content Mapping properties as needed to synchronize metadata changes and physical changes.
Administering Roles

The User Manager in SAS Management Console provides roles and capabilities that you can assign to users. When a user profile is assigned to a role, that user has access to the capabilities that are selected for that role in the User Manager.

Opening the User Manager displays roles for the following desktop applications:

- SAS Management Console
- SAS Add-In for Microsoft Office (see “Default Roles and Capabilities for the SAS Add-In for Microsoft Office” on page 32)
- SAS Enterprise Guide (see “Default Roles and Capabilities for SAS Enterprise Guide” on page 126)
- SAS Web Report Studio (see the SAS Intelligence Platform: Web Application Administration Guide)

SAS Management Console provides two default roles: Advanced and Content Management. The following table describes the capabilities that are assigned to those roles by default. In the User Manager, you can change the capabilities of a role or add new roles with unique sets of capabilities.

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Category</td>
<td></td>
<td>Advanced</td>
</tr>
<tr>
<td>Access Unregistered Plug-ins</td>
<td>Access plug-ins that are not registered in metadata.</td>
<td>X</td>
</tr>
<tr>
<td>Plug-ins Category</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Application Monitor</td>
<td>Monitor the activities of applications, subsystems and services.</td>
<td>X</td>
</tr>
<tr>
<td>Authorization Manager</td>
<td>Manage resource access control policies.</td>
<td>X</td>
</tr>
<tr>
<td>Data Library Manager</td>
<td>Manage the definitions of data libraries and database schemas.</td>
<td>X</td>
</tr>
<tr>
<td>Folder View</td>
<td>Manage public and user folders used to store metadata objects.</td>
<td>X</td>
</tr>
<tr>
<td>Foundation Services Manager</td>
<td>Manage Foundation Services components.</td>
<td>X</td>
</tr>
<tr>
<td>Metadata Manager</td>
<td>Create and manage metadata repositories, manage the current SAS Metadata Server, and run metadata utilities.</td>
<td>X</td>
</tr>
<tr>
<td>Publishing Framework</td>
<td>Manage publishing framework subscribers and content channels.</td>
<td>X</td>
</tr>
<tr>
<td>Schedule Manager</td>
<td>Manage SAS jobs to be scheduled, create conditional events for schedules, and submit jobs for scheduling.</td>
<td>X</td>
</tr>
<tr>
<td>Server Manager</td>
<td>Create and manage server definitions (such as for SAS servers, database servers, and spawners).</td>
<td></td>
</tr>
<tr>
<td>User Manager</td>
<td>Create and manage users, groups, roles, and capabilities.</td>
<td>X</td>
</tr>
</tbody>
</table>
Here is the recommended reading list for this title:

- Application Messaging with SAS
- SAS Data Integration Studio: User's Guide
- SAS Environment Manager: User's Guide
- SAS Intelligence Platform: Application Server Administration Guide
- SAS Intelligence Platform: Data Administration Guide
- SAS Intelligence Platform: Installation and Configuration Guide
- SAS Intelligence Platform: Overview
- SAS Intelligence Platform: Security Administration Guide
- SAS Intelligence Platform: System Administration Guide
- SAS Intelligence Platform: Web Application Administration Guide
- Scheduling in SAS
- The Little SAS Book: A Primer

For a complete list of SAS publications, go to sas.com/store/books. If you have questions about which titles you need, please contact a SAS Representative:

SAS Books
SAS Campus Drive
Cary, NC 27513-2414
Phone: 1-800-727-0025
Recommended Reading

Fax: 1-919-677-4444
Email: sasbook@sas.com
Web address: sas.com/store/books
connection profile
  a client-side definition of where a metadata server is located. The definition includes
  a computer name and a port number. In addition, the connection profile can also
  contain user connection information.

flow
  a set of jobs and associated dependencies that is scheduled in the Schedule
  Manager plug-in in SAS Management Console.

metadata repository
  a collection of related metadata objects, such as the metadata for a set of tables and
  columns that are maintained by an application.

metadata server
  a server that provides metadata management services to one or more client
  applications.

OLAP
  See online analytical processing.

online analytical processing (OLAP)
  a software technology that enables users to dynamically analyze data that is stored
  in multidimensional database tables (cubes).

SAS Management Console
  a Java application that provides a single user interface for performing SAS
  administrative tasks.
SAS Metadata Repository
a container for metadata that is managed by the SAS Metadata Server. See also SAS Metadata Server.

SAS Metadata Server
a multi-user server that enables users to read metadata from or write metadata to one or more SAS Metadata Repositories.

SAS OLAP Cube Studio
a Java interface for defining and building OLAP cubes in SAS System 9 or later. Its main feature is the Cube Designer wizard, which guides you through the process of registering and creating cubes.

SAS OLAP Server
a SAS server that provides access to multidimensional data. The data is queried using the multidimensional expressions (MDX) language.

schema
a map or model of the overall data structure of a database. A schema consists of schema records that are organized in a hierarchical tree structure. Schema records contain schema items.

star schema
tables in a database in which a single fact table is connected to multiple dimension tables. This is visually represented in a star pattern. SAS OLAP cubes can be created from a star schema.

tuple
a data object that contains two or more components. In OLAP, a tuple is a slice of data from a cube. It is a selection of members (or cells) across dimensions in a cube. It can also be viewed as a cross-section of member data in a cube. For example, ([time].[all time].[2003], [geography].[all geography].[u.s.a.], [measures].[actualsum]) is a tuple that contains data from the Time, Geography, and Measures dimensions.
**wizard**

an interactive utility program that consists of a series of pages. Users supply information on each page, and the wizard uses that information to perform a task.
Glossary
access control for information maps 153
application server
defining for remote job processing 73
authentication, Integrated Windows 7

batch job deployment directory 73
bulk loading data 79

change management
creating a change-managed folder 66
project repositories 67
repository directories 67
setting up 64
client machine
setting up for SAS Data Integration Studio 71

configuration
IBM WebSphere MQ software 77
Microsoft MSMQ software 76
SAS Data Quality Server 82
SAS Information Map Studio 156
SAS Management Console 161
SAS OLAP Cube Studio 55
connection profiles
creating, editing, and deleting 9
credentials stored in 8
for SAS Add-In for Microsoft Office 20
for SAS Data Integration Studio 61
for SAS Enterprise Guide 104
for SAS Management Console 164
initial custom profile for SAS Enterprise Guide 110
no-profile mode 22
overview 6
shared profile deployment for SAS Add-In for Microsoft Office 23
shared profile deployment for SAS Enterprise Guide 108
updating with update configuration files 23
custom action 89

GridMonitor plug-in for SAS Management Console 62

HTTP
retrieving files with 90

IBM WebSphere MQ software
creating a message queue polling server for 77
installing and configuring 77
information maps
access control 153
data sources for 151
installing desktop applications 2
Integrated Windows authentication 7

Java Access Bridge (JAB), installing 3
Java heap, managing size 12
job deployment, remote 73
job processing, remote 72

grid computing 62
libraries

access for SAS Add-In for Microsoft Office 51
access for SAS Enterprise Guide 114
defining 70
local files 11
redirecting 162
local host, setting up 69
locales, downloading 85
lockdown state
SAS Add-In for Microsoft Office 29
SAS Enterprise Guide 124
log files 11
managing in SAS Information Map Studio 154
routing information to 87

message queues 74
managing 78
registering metadata for 78
requirements for 75
metadata
defining tables for remote host 71
registering for message queues 78
metadata servers 6
Microsoft MSMQ software 74
installing and configuring 76
Microsoft Office software 16
migrating desktop applications 6
multi-tier environments
remote data access 68
SAS Data Integration Studio 68
New Server wizard
retrieving files with FTP or HTTP 90
object spawners
configuring for bulk loading 79
OLAP cubes 53
OLAP servers 56
output, redirecting 87
Perl scripts
X command options for 81
pooled workspace servers 153
project repository, creating 67
R
remote data access 68
testing setup with View Data 71
remote host
defining tables in metadata for 71
setting up 70
remote job deployment 73
remote job processing 72
remote SAS/CONNECT server 70
repository directory
creating 67
roles
administering for SAS Add-In for Microsoft Office 32
routing log information 87

S
SAS Add-In for Microsoft Office 16
administering connection profiles 20
administering roles 32
library access 51
selecting a default server 22
SAS Data Integration Studio 59
administrative tasks 59
change management 64
client machine 71
connecting to data servers 63
connecting to SAS servers 61
data quality options 87
logging information to a file 87
multi-tier environments 68
redirecting output 87
registering DataFlux Integration Servers 84
remote job deployment 73
remote job processing 72
scheduling servers 64
setting grid server options 62
setting up SAS Data Quality Server 81
status code handling 88
SAS Data Quality Server 81
configuring 82
creating schemes 86
data quality options 87
downloading locales 85
setting up 81
testing 83
SAS Enterprise Guide 95
administering connection profiles 104
library access 114
selecting a default workspace server 107
SAS Enterprise Miner 147
SAS ETL Studio 59
SAS Grid Manager 62
SAS Grid Monitor server 62
SAS Information Map Studio
administrative tasks 150
configuration 156
logging on 151
managing the log file 154  
registering input resources 151  
SAS Intelligence Platform  
setting up for SAS OLAP Cube Studio 54  
SAS Management Console 158  
administering connection profiles 164  
administrative tasks 158  
configuration 161  
Folders tab 164  
Grid Monitor plug-in for 62  
redirecting local files 162  
SAS OLAP Server Monitor for 55  
Server Manager plug-in for 90  
starting 162  
User Manager plug-in for 10  
SAS Metadata Server  
connecting from SAS Data Integration Studio 61  
connection profiles 6  
SAS OLAP Cube Studio 53  
administering OLAP servers 56  
configuration 55  
setting up SAS Intelligence Platform for 54  
SAS OLAP Server Monitor for  
SAS Management Console 55  
SAS servers  
administering OLAP servers 56  
connecting from SAS Data Integration Studio 61  
selecting default for SAS Add-In for Microsoft Office 22  
SAS Workspace Servers 153  
SAS/CONNECT server remote, setting up 70  
scheduling  
SAS Data Integration Studio jobs 64  
scheduling servers 64  
schemes  
creating 86  
shell scripts  
X command options for 81  
status code handling 88  
custom action 89  
email action 89  
T  
tables  
defining in metadata for remote host 71  
testing  
SAS Data Quality Server 83  
U  
update configuration files 23  
User Manager plug-in for SAS Management Console 10  
user-defined formats
<table>
<thead>
<tr>
<th>V</th>
<th>making available 152 users adding to SAS Information Map Studio 151</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>View Data 71 WebSphere MQ software 77 workspace servers connecting from SAS Data Integration Studio 61</td>
</tr>
<tr>
<td>X</td>
<td>defining for remote job processing 73 enabling to execute operating system commands 79 pooled 153 selecting default for SAS Enterprise Guide 107 X command options for running Perl or shell scripts 81</td>
</tr>
</tbody>
</table>